
Oracle Application Integration 
Architecture Release 1.0
Siebel CRM Integration 
Pack for Oracle Order 
Management 
Implementation Guide

 
May 2007



 

Copyright © 2007, Oracle. All rights reserved. Part Number: E05443-01

The Programs (which include both the software and documentation) contain proprietary information; 
they are provided under a license agreement containing restrictions on use and disclosure and are also 
protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, 
disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability 
with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems 
in the documentation, please report them to us in writing. This document is not warranted to be error-
free. Except as may be expressly permitted in your license agreement for these Programs, no part of 
these Programs may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, for any purpose.

PRODUCT MODULES AND OPTIONS. This guide contains descriptions of modules that are optional and 
for which you may not have purchased a license. Siebel’s Sample Database also includes data related to 
these optional modules. As a result, your software implementation may differ from descriptions in this 
guide. To find out more about the modules your organization has purchased, see your corporate 
purchasing agent or your Siebel sales representative.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs 
on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS. Programs, software, databases, and related documentation and technical 
data delivered to U.S. Government customers are “commercial computer software” or “commercial 
technical data” pursuant to the applicable Federal Acquisition Regulation and agency-specific 
supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the 
Programs, including documentation and technical data, shall be subject to the licensing restrictions set 
forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set 
forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, 
Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy and other measures to ensure the safe use of such applications if the Programs are used for 
such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle, JD Edwards, PeopleSoft, and Siebel are registered trademarks of Oracle Corporation and/or its 
affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third 
parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. 
You bear all risks associated with the use of such content. If you choose to purchase any products or 
services from a third party, the relationship is directly between you and the third party. Oracle is not 
responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of 
the agreement with the third party, including delivery of products or services and warranty obligations 
related to purchased products or services. Oracle is not responsible for any loss or damage of any sort 
that you may incur from dealing with any third party. 



Contents
Siebel CRM Integration Pack for Oracle Order Management Implementation Guide 1

Chapter 1:  Introduction to Siebel CRM Integration Pack for 
Oracle Order Management

Preface 7

TTY Access to Oracle Support Services 7

Documentation Accessibility 7
Accessibility of Code Examples in Documentation 7
Accessibility of Links to External Web Sites in Documentation 7
Support 8

Structure 8

Related Documents 8

Do Not Use Database Tools to Modify Oracle Applications Data 8

Glossary and Abbreviations 9

Chapter 2:  Siebel CRM Integration Pack for Oracle Order 
Management Environment

About Siebel CRM Integration Pack for Oracle Order Management 11

Software Requirements 12

Chapter 3:  Installation and Configuration
Installation and Configuration Summary 13

Downloading Required Software for Installation 14

Installing Fusion Middleware Software 15

Installing Oracle E-Business Suite Patches 16

Installing Fusion Middleware and JDeveloper Patches 17

Deploying the Integration Files 18
Extracting the Integration Files 18
Locating Integration Files 19
Configuring Integration Files 19

Configuring the Oracle E-Business Suite Environment 20
Configuring the Customer Integration Point in Oracle E-Business Suite 20
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide

3



Contents ■ 
Configuring Payment Authorization Integration Point in Oracle E-Business Suite 21
Setting up Oracle Configurator 21
Installing Business Processes Execution Language Wrapper Packages to Oracle E-Business 
Suite 24

Configuring the Siebel CRM Environment 24
Applying Quick Fix 25
Configuring the Customer Integration Point in Siebel CRM 25
Configuring the Products Integration Point 27
Configuring the Orders Integration Point 30
Configuring State Model for Orders 32
Configuring State Model for OrderUpdate 33
Configuring the Quotes Integration Point 34
Configuring the Configurator Integration Point 36
Configuring the Assets Integration Point 45
Configuring the Application Programming Interfaces 46

Configuring Oracle E-Business Suite Application Server 49
Setting Up Asynchronous Error Handling 49
Defining Connection Pools 50
Defining Datasources 51
Defining Adapter Connection Factories 52
Setting up Common Functions 53
Importing ID Cross-Reference Seed Data 54
Creating Mapped Siebel Business Units for Oracle Operating Units (Organizations) 55
Validating and Loading Data Value Maps 61

Deploying Business Processes Execution Language Processes 63

Chapter 4:  Data Loading
Prerequisites 69

Overview of Data Loading 69

Loading Customer Data 70
Overview of Customer Data Bulk Load 70
Prerequisites for Loading Customer Data 71
Loading Customer and Contact Data 72

Loading Products Data 79
Overview of Products Data Bulk Load 79
Prerequisites for Loading Product Data 79
Loading Product Data 79

Loading Price List Data 83
Overview of Price List Data Bulk Load 83
Siebel CRM Integration Pack for Oracle Order Management Implementation 
Guide  

4 



Contents ■
Prerequisites for Loading Price List Data 84
Loading Price List Data 86

Loading Asset Data 89
Overview of Asset Data Bulk Load 89
Prerequisites for Loading Asset Data 89
Loading Asset Data 90

Chapter 5:  Integrations
Overview of Integration Points 93

Customer Integration Point 94
Overview of the Customer Data Integration Point 95
Prerequisites for Customer Data Integration 95
Synchronizing Customer Data from Oracle E-Business Suite to Siebel CRM 97
Synchronizing Customer Data from Siebel CRM to Oracle E-Business Suite 103
Notes on the Customer Integration Point 109

Products Integration Point 109
Overview of the Product Data Integration Point 110
Prerequisites for the Product Data Integration Point 110
Synchronizing Simple Product (Item) Data 111
Synchronizing Complex Product (BOM) Data 113

Price List Integration Point 114

Asset Integration Point 115
Overview of the Asset Data Integration Point 115
Prerequisites for the Asset Data Integration Point 115
Synchronizing Asset Data 115

Order Integration Point 117
Notes on the Order Integration Point 117
Orders and Quotes 121
Oracle Configurator Integration 123
Available To Promise (ATP) 124
Credit Check 125
Payment Authorization 126
Shipping Charges 127
Pricing, Tax, and Invoicing 127

Chapter 6:  Troubleshooting

Index
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide

5



Contents ■ 
Siebel CRM Integration Pack for Oracle Order Management Implementation 
Guide  

6 



1 Introduction to Siebel CRM 
Integration Pack for Oracle 
Order Management
Preface
Welcome to the Siebel CRM Integration Pack for Oracle Order Management Implementation Guide.

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United 
States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation accessible, with good 
usability, to the disabled community. To that end, our documentation includes features that make 
information available to users of assistive technology. This documentation is available in HTML 
format, and contains markup to facilitate access by the disabled community. Accessibility standards 
will continue to evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be accessible to 
all of our customers. For more information, visit the Oracle Accessibility Program Web site at http:/
/www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The conventions 
for writing code require that closing braces should appear on an otherwise empty line; however, some 
screen readers may not always read a line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in 
Documentation
This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide
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Introduction to Siebel CRM Integration Pack for Oracle Order Management ■ 
Structure
Support
Available 24/7, the Oracle Metalink site is a single access point to a wide range of help, 
documentation, and support resources that help you get more out of Oracle products. It provides 
access to create and modify service requests as well as view system status alerts and notifications.    
To access the Service requests, click the Service Request tab after logging into Oracle Metalink. 

Structure
1 Introduction to Siebel CRM Integration Pack for Oracle Order Management

2 Siebel CRM Integration Pack for Oracle Order Management Environment

3 Integrations

4 Installation and Configuration

5 Data Loading

6 Troubleshooting

Related Documents
For more information, read the following documents:

■ Oracle Configurator Implementation Guide

■ Oracle Order Management Implementation Manual

■ Oracle Order Management User's Guide

Do Not Use Database Tools to Modify 
Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database 
triggers, or any other tool to modify Oracle Applications data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain 
information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle 
Applications data, you risk destroying the integrity of your data and you lose the ability to audit 
changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle 
Applications form can update many tables at once. But when you modify Oracle Applications data 
using anything other than Oracle Applications, you may change a row in one table without making 
corresponding changes in related tables. If your tables get out of synchronization with each other, 
you risk retrieving erroneous information and you risk unpredictable results throughout Oracle 
Applications.
Siebel CRM Integration Pack for Oracle Order Management Implementation 
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Introduction to Siebel CRM Integration Pack for Oracle Order Management ■
Glossary and Abbreviations
When you use Oracle Applications to modify your data, Oracle Applications automatically checks that 
your changes are valid. Oracle Applications also keeps track of who changes information. If you enter 
information into database tables using database tools, you may store invalid information. You also 
lose the ability to track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

Glossary and Abbreviations
Account. In Oracle E-Business Suite an account describes the specific attributes of a party that are 
relevant to the selling relationship that the implementing organization has established with a party. 
An account in Oracle cannot exist by itself without a party. It can be associated with an individual 
(person) or a company (organization). In Siebel CRM an account describes an organization customer.

BOM. Bill of materials - defines components and hierarchy of a product.

BPEL. Business Processes Execution Language, a standards-based extensible language.

Contact. In Oracle E-Business Suite a contact describes a specific relationship between two parties, 
more specifically between an Organization and a Person party, which is also called an Organization 
Contact. The Organization Contact can also be associated with a Customer Account in Oracle, which 
is then called an Account Contact. In Siebel CRM a contact describes an individual customer that may 
or may not be related to an Account (Organization customer) or another Contact (individual 
customer).

Customer. In Oracle E-Business Suite a customer is defined as a party with whom the 
implementing organization has established a selling relationship. All relevant information of the 
specific selling relationship with a party is modeled in the account layer entities in Oracle, whereas 
all the base information like name, address information, contact points are modeled in the party layer 
entities. A customer in Oracle can be an individual (person) in case of a Business-to-Consumer 
relationship or a company (organization) in case of a Business-to-Business relationship. In Siebel 
CRM a customer can be either modeled as an Account or as a Contact. An Account in Siebel is the 
equivalent of an organization party + account in Oracle and a Contact is the equivalent of a person 
party + account in Oracle.

DVM. Data Value Map

EBS. Oracle E-Business Suite Applications

FMW. Fusion Middleware

Item. A product or service that is manufactured or sold. Item can be used to represent grouping 
assemblies or placeholder such as phantoms.

Middleware. Integration software that is used to connect applications, such as Webmethods.

Organization. A business unit such as a plant, warehouse, division, department, and so on. Order 
Management refers to organizations as warehouses on all Order Management windows

OWB. Oracle Warehouse Builder
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide
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Introduction to Siebel CRM Integration Pack for Oracle Order Management ■ 
Glossary and Abbreviations
Party. In the Oracle E-Business Suite, more specifically in the Trading Community Architecture 
(TCA), a party is defined as any individual or organization with whom the implementing organization 
can do business. A party in Oracle TCA could be a customer, in case a selling relationship has been 
established or for example a vendor or an employee. The same party can have multiple such roles 
within Oracle E-Business Suite. In the context of this integration solution we only address those 
parties in Oracle E-Business Suite that represent customer data. The concept of a party does not 
exist in Siebel CRM.
Siebel CRM Integration Pack for Oracle Order Management Implementation 
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2 Siebel CRM Integration Pack for 
Oracle Order Management 
Environment
This chapter contains the following information:

■ About Siebel CRM Integration Pack for Oracle Order Management on page 11

■ Software Requirements on page 12

About Siebel CRM Integration Pack for 
Oracle Order Management
The Siebel CRM Integration Pack for Oracle Order Management integration supports the ability to 
create a seamless opportunity-to-cash business process. A quote or order created in Siebel Quote 
and Order Capture can generate an order in Oracle E-Business Suite (EBS) Order Management.

The integration also includes additional touch points between Siebel CRM and Oracle EBS that are 
required to enable this process: customer, product, price list, and asset synchronization.

It also supports generation of an Oracle Order Management order from Siebel Quotes and RMAs. In 
addition, Siebel quotes and orders can query Oracle EBS in real-time for information including 
availability, shipping cost, credit check, and payment validation.

Lastly it provides the capability for the Oracle EBS Configurator to be called from a Siebel quote or 
order to ensure that complex products can be easily processed for fulfillment
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide
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Siebel CRM Integration Pack for Oracle Order Management Environment ■ Software 
Requirements
The capabilities are summarized in Figure 1.

Software Requirements
The Siebel CRM Integration Pack for Oracle Order Management Integration Pack requires the 
following versions:

■ Oracle Application Server 10.1.3.1, Enterprise Edition

■ Oracle E-Business Suite, 11.5.10 CU2

■ Oracle JDeveloper 10.1.3.1 (upgraded to the latest patch)

■ Oracle SOA Suite 10.1.3.1 (upgraded to the latest patch)

■ Oracle Warehouse Builder 10gR2 (Optional)

■ Siebel CRM V7.8.2.4 HOR

Figure 1. Order Integration Overview
Siebel CRM Integration Pack for Oracle Order Management Implementation 
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3 Installation and Configuration
This chapter contains the following information:

■ Installation and Configuration Summary on page 13

■ Downloading Required Software for Installation on page 14

■ Installing Fusion Middleware Software on page 15

■ Installing Oracle E-Business Suite Patches on page 16

■ Installing Fusion Middleware and JDeveloper Patches on page 17

■ Deploying the Integration Files on page 18

■ Configuring the Oracle E-Business Suite Environment on page 20

■ Configuring the Siebel CRM Environment on page 24

■ Configuring Oracle E-Business Suite Application Server on page 49

■ Deploying Business Processes Execution Language Processes on page 63

Installation and Configuration Summary
Use the following summary to help you keep track of the installation sequence and your progress 
through it.

■ Downloading Required Software for Installation on page 14

■ Installing Fusion Middleware Software on page 15

■ Installing Oracle E-Business Suite Patches on page 16

■ Installing Fusion Middleware and JDeveloper Patches on page 17

■ Deploying the Integration Files on page 18

■ Extracting the Integration Files on page 18

■ Locating Integration Files on page 19

■ Configuring Integration Files on page 19

■ Configuring the Oracle E-Business Suite Environment on page 20

■ Configuring the Customer Integration Point in Oracle E-Business Suite on page 20

■ Configuring Payment Authorization Integration Point in Oracle E-Business Suite on page 21

■ Setting up Oracle Configurator on page 21

■ Installing Business Processes Execution Language Wrapper Packages to Oracle E-Business 
Suite on page 24
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide
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Installation and Configuration ■ Downloading Required Software for Installation
■ Configuring the Siebel CRM Environment on page 24

■ Applying Quick Fix on page 25

■ Configuring the Customer Integration Point in Siebel CRM on page 25

■ Configuring the Products Integration Point on page 27

■ Configuring the Orders Integration Point on page 30

■ Configuring State Model for Orders on page 32

■ Configuring State Model for OrderUpdate on page 33

■ Configuring the Quotes Integration Point on page 34

■ Configuring the Configurator Integration Point on page 36

■ Configuring the Assets Integration Point on page 45

■ Configuring the Application Programming Interfaces on page 46

■ Configuring Oracle E-Business Suite Application Server on page 49

■ Setting Up Asynchronous Error Handling on page 49

■ Defining Connection Pools on page 50

■ Defining Datasources on page 51

■ Defining Adapter Connection Factories on page 52

■ Setting up Common Functions on page 53

■ Importing ID Cross-Reference Seed Data on page 54

■ Creating Mapped Siebel Business Units for Oracle Operating Units (Organizations) on page 555

■ Validating and Loading Data Value Maps on page 61

■ Deploying Business Processes Execution Language Processes on page 63

Downloading Required Software for 
Installation
The required software for Siebel CRM Integration Pack for Oracle Order Management is available on 
Oracle E-Delivery.

To download the files

1 Log in to Oracle E-Delivery (http://edelivery.oracle.com).

2 From the Product Pack menu, choose Oracle Application Integration Architecture.

3 From the Platform menu, choose your platform, and click Go.

4 Download the following files:
Siebel CRM Integration Pack for Oracle Order Management Implementation 
Guide  
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Installation and Configuration ■ Installing Fusion Middleware Software
■ Siebel CRM Integration Pack for Oracle Order Management Implementation Guide 
(Documentation_OMIPv1.0.zip)

■ Oracle Database 10g Release 2 (10.2.0.1) (file name(s) and count vary by platform)

■ Oracle Database 10g Release 2 Patches (DB_Patches_AIAv1.0.zip)

■ Oracle SOA Suite 10g (10.1.3.1.0) (file name(s) and count vary by platform)

■ Oracle Fusion Middleware 10.1.3.1 Patches (FMW_Patches_AIAv1.0.zip)

■ Siebel CRM Integration Pack for Oracle Order Management, E-Business Suite Generic Patch 
(EBS_Patches_AIAv1.0.OM_generic.tar)

■ Siebel CRM Integration Pack for Oracle Order Management, E-Business Suite Operating 
System Patch (as needed)

■ Siebel CRM Integration Pack for Oracle Order Management, v1.0, Siebel CRM Patches

■ Siebel CRM Integration Pack for Oracle Order Management, v1.0 
(SEBLOrderCapIntegPkEBSOMv1.0.zip)

Installing Fusion Middleware Software
Install the following Fusion Middleware components:

1 Oracle Database 10g Release 2 (10.2.0.1) Enterprise Edition. 
Download and install the database only if you do not already have an Oracle 10.2.0.2 (or higher) 
database instance available for the SOA Suite to access. For information on installing Oracle 
Database, refer to the Oracle Technology Network. Oracle Technology Network link has the 
following URL:
http://www.oracle.com/technology/documentation/index.html
After installation, apply the appropriate patch from DB_Patches_AIAv1.0.zip (choose the patch 
appropriate to the operating system that your database is installed on.) This patch brings the 
database up to required version 10.2.0.2.

Operating System Patch File Name

AIX Based Systems (32-bit) EBS_Patches_AIAv1.0.OM_aix.tar

HP Tru64 UNIX EBS_Patches_AIAv1.0.OM_tru64.tar

HP-UX PA-RISC (32-bit) EBS_Patches_AIAv1.0.OM_hpux11.tar

Linux x86 EBS_Patches_AIAv1.0.OM_linux.tar

Microsoft Windows (32-bit) EBS_Patches_AIAv1.0.OM_winnt.tar

Solaris Operating System (SPARC 32-bit EBS_Patches_AIAv1.0.OM_solaris.tar
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide
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Installation and Configuration ■ Installing Oracle E-Business Suite Patches
2 SOA Suite 10g10.1.3.1
For information on installing Oracle SOA Suite, refer to the Oracle Application Server 
Documentation Library. The library is available on the Oracle Technology Network.
Oracle Technology Network link has the following URL:
http://www.oracle.com/technology/documentation/index.html.
Click Oracle Application Server 10g Release 3 (10.1.3.1)
Make sure to install the full SOA suite using the Advanced Installation Mode.

3 Oracle JDeveloper 10.1.3.1 (Studio Version)
Download Oracle JDeveloper from:
http://www.oracle.com/technology/software/products/jdev/archives.html.
This is a free download. Support for JDeveloper is not included. If desired, support for JDeveloper 
can be purchased separately. For information on installing Oracle JDeveloper, refer to the Oracle 
Technology Network. Oracle Technology Network link has the following URL:
http://www.oracle.com/technology/documentation/index.html

4 Oracle Warehouse Builder 10gR2 10.2.0.1 (optional component)
Oracle Warehouse Builder is an optional component that should be used to perform initial data 
synchronization from Oracle E-Business Suite to Siebel CRM if customer or product data already 
exists in Oracle E-Business Suite. Use of OWB for initial data synchronization requires the ETL 
and Data Quality options from Oracle Warehouse Builder. OWB is not included in this media pack 
and, if needed, must be licensed separately.

Installing Oracle E-Business Suite 
Patches
Install the Oracle E-Business Suite patches described in this section. If a patch has already been 
installed, there is no need to reinstall it. The latest version of each patch can be downloaded from 
http://metalink.oracle.com.

NOTE: Always check Metalink for the latest versions of all patches.

To install Oracle E-Business Suite Patches

1 Download the Oracle E-Business Suite generic patch. The file name is:
EBS_Patches_AIAv1.0.OM_generic.tar

2 Use the tar utility to extract the Oracle E-Business Suite patches from the generic patch file.

Extracting from the generic patch file yields a set of platform-independent patch zip files

3 Apply each of these patches to your Oracle E-Business Suite application.

4 Download the Oracle E-Business Suite patches specific to your operating system.

Operating System Patch File Name

AIX Based Systems (32-bit) EBS_Patches_AIAv1.0.OM_aix.tar

HP Tru64 UNIX EBS_Patches_AIAv1.0.OM_tru64.tar
Siebel CRM Integration Pack for Oracle Order Management Implementation 
Guide  
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Installation and Configuration ■ Installing Fusion Middleware and JDeveloper Patches
5 Use the tar utility to extract the patch files from the operating system-specific file.

6 Apply each of these patches to your Oracle E-Business Suite application.

7 Install the patches listed in Table 1, in the specific order of installation.

Installing Fusion Middleware and 
JDeveloper Patches
Install all Fusion Middleware and JDeveloper patches described in this section. If any particular patch 
has already been installed, there is no need to reinstall it. The latest version of each patch can be 
downloaded from http://metalink.oracle.com.

HP-UX PA-RISC (32-bit) EBS_Patches_AIAv1.0.OM_hpux11.tar

Linux x86 EBS_Patches_AIAv1.0.OM_linux.tar

Microsoft Windows (32-bit) EBS_Patches_AIAv1.0.OM_winnt.tar

Solaris Operating System (SPARC 32-bit EBS_Patches_AIAv1.0.OM_solaris.tar

Table 1. Patches Needed for Oracle E-Business Suite

Order Patch Number Comments

1 4676589 ATG Rollup Patch 4

2 3618299 TCA Patchset HZ.n

3 5506763 Assets - 11.5.10 CSI Consolidated bugs.

4 5506773 Assets - 11.5.10 CSE Consolidated bugs

5 4639052 11.5.10 ATP rollup#7 patch

6 5667693 CLAF fixes

7 4280097 Customer - HZ.N fixes party merge

8 5046954 Customer - TCA Backported Integration Service Patch

9 5221609 Customer – Integration patch

10 5518136 Order – Integration patch

11 5617696 Complex Products – Integration patch

12 5685529 Assets - Integration patch

13 5713146 ATP - Integration patch

14 5971958 Oracle Configurator - Integration patch

15 6021155 Simple Products - Integration patch

Operating System Patch File Name
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide
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Installation and Configuration ■ Deploying the Integration Files
To install SOA Suite patches

1 Download the Fusion Middleware and JDeveloper patches. The file name is:
FMW_Patches_AIAv1.0.zip

2 Unzip the file to yield the mandatory bug-fix patches listed in the following table.

3 Apply each of these patches to your installation.

4 Refer to the ReadMe.txt in each patch for guidance on how to apply the patch.

Deploying the Integration Files
Use the following topics for instructions on the deploying, locating, and configuring the integration 
files:

■ Extracting the Integration Files on page 18

■ Locating Integration Files on page 19

■ Configuring Integration Files on page 19

Extracting the Integration Files
Use the following procedure to extract the integration files.

Patch Number Comments

5473225 Fixes problems that involve catching an exception during a transform.

5596476 Fixes problems that involve the XSLT map not rendering in the user 
interface.

5609537 Fixes issues with commit in child processes.

5917910 Fixes problems that involve:

■ Creating <XSL:variable> with value "&#0;"

■ Java heap error on Service Oriented Architecture Suite, V10.1.3.1 
release on Linux.

■ Invoking PL/SQL procedure with a large output parameter.

5931554 Fixes problems that involve:

■ Cross-reference feature

■ XPATH function, LOOKUP-DVM, but does not work in assign activity of 
Business Processes Execution Language.
Siebel CRM Integration Pack for Oracle Order Management Implementation 
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Installation and Configuration ■ Deploying the Integration Files
To extract the integration files

1 Unzip file SEBLOrderCapIntegPkEBSOMv1.0.zip under <SOA Suite Home>/BPEL directory (this 
directory is created during the SOA Suite Installation.)

2 Unzip SEBLOrderCapIntegPkEBSOMv1.0.zip. Unzipping extracts the integration files into a new 
directory named:
SEBLODIntegPkEBSOM.

Locating Integration Files
The integration files are contained in the SEBLOrderCapIntegPkEBSOM directory. This directory was 
created when you unzipped SEBLOrderCapIntegPkEBSOMv1.0.zip.

The SEBLOrderCapIntegPkEBSOM directory contains the following directories:

■ BulkDataLoad. Has content for performing an initial data load of customer and product data 
from Oracle E-Business Suite to Siebel CRM, if necessary.

■ BusinessProcesses. Has content for ongoing synchronization. These are the Oracle Business 
Processes Execution Language (BPEL) processes and related content.

■ SetUp. Contains setup content for BPEL Processes.

■ SharedComponents. Has shared components for BPEL Processes. You need these directories 
and their files to complete the remaining installation and configuration tasks.

The location in which the SEBLOrderCapIntegPkEBSOM directory is placed, is referred to as 
CRMINTEG_HOME throughout this document. The SOA Suite install location is referred to as 
SOA_HOME throughout the document.

Copy the SEBLOrderCapIntegPkEBSOM directory to your SOA_SUITE install machine, and place it a 
directory such as SOA_HOME/bpel/samples. Many of the deployment steps require tools and scripts 
available as part of SOA Suite.

Configuring Integration Files
Before using and deploying the integration code, you must run a script that replaces machine names 
and URLs with your deployment environment location information. The following procedure covers 
editing those parameters and running the script.

To configure integration files

1 On the computer where SOA Suite is installed open a command prompt or shell.

2 Change Directory to CRMINTEG_HOME/SetUp.

3 Open the following file:

CRMIntegProcessParameters.xml
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide
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Installation and Configuration ■ Configuring the Oracle E-Business Suite Environment
4 Examine each parameter and replace the current parameter value with values appropriate for 
your installation.

5 Save the file.

6 Change directory to CRMINTEG_HOME/SetUp/scripts.

7 Execute the following command:

a For Windows:

%SOA_HOME%/jdk/bin/java -jar EditParam.jar -i %CRMINTEG_HOME%\BusinessProcesses -f 
%CRMINTEG_HOME%\SetUp\CRMIntegProcessParameters.xml -verbose -t D:\temp

b For Linux:

%SOA_HOME%/jdk/bin/java -jar EditParam.jar -i $CRMINTEG_HOME/BusinessProcesses -f 
$CRMINTEG_HOME/SetUp/CRMIntegProcessParameters.xml -verbose -t /tmp

Configuring the Oracle E-Business Suite 
Environment
Complete the following procedures to configure the Oracle EBS environment:

■ Configuring the Customer Integration Point in Oracle E-Business Suite on page 20

■ Configuring Payment Authorization Integration Point in Oracle E-Business Suite on page 21

■ Setting up Oracle Configurator on page 21

■ Installing Business Processes Execution Language Wrapper Packages to Oracle E-Business Suite on 
page 24

Configuring the Customer Integration Point in Oracle 
E-Business Suite
The customer integration points needs specific profile options set.

To configure the customer integration point

1 Log in to Oracle EBS using the System Administrator responsibility.

2 Open the System Profile Values form.

3 Using the following table, query these profile options, and set the indicated values at the site 
level.

Profile Option Value

HZ: Execute API Callouts All Events Enabled

HZ: Format Business Object Business Events as Bulk N
Siebel CRM Integration Pack for Oracle Order Management Implementation 
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Installation and Configuration ■ Configuring the Oracle E-Business Suite Environment
Configuring Payment Authorization Integration Point in 
Oracle E-Business Suite
For the Payment Authorization integration point configuration, use the following procedure.

To configure the payment authorization integration point

1 Log into Oracle EBS.

2 Navigate to System Administrator > Profile > System.

3 Query for "IBY: ECAPP URL" and change its value to:

"http://<host machine name.us.oracle.com>:<port number>/oa_servlets/ibyecapp"

Example:

http qapache.us.oracle.com:3908/oa_servlets/ibyecapp

4 Set the Servlet base URL to:

http:// <host machine name.us.oracle.com>:<port number>/oa_servlets

5 Add the Responsibility for the user (SYSADMIN).

a Navigate to System Administrator > Security: User > Define.

b Query for User (SYSADMIN).

c Add the responsibility "IPayment Payment Administrator".

6 Navigate to IPayment Payment Administrator > iPayment Administrator.

7 In the iPayment UI navigate to Setup tab > Payment Systems tab.

8 Click on the update icon of SamplePaymentSystem and change the value for Servlet base URL to: 

"http:// <host machine name.us.oracle.com>:<port number>/oa_servlets"

Example:

http://qapache.us.oracle.com:3908/oa_servlets

Setting up Oracle Configurator
To set up Oracle Configurator use the following procedure.

To set up Oracle Configurator

1 Use an existing model or create a new configuration model in Oracle Configurator Developer.

2 Configuration Model Publication

a Create a Siebel Application.

b Change responsibility to System Administrator.
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c Choose Application > Register.

d Add the following new entries for Siebel Quote Integration:

❏ SEBLQ

❏ DUMMY_TOP

❏ Provides integration between Siebel Quote and Oracle Configurator

e Add the following new entries for Siebel Order Entry Integration:

❏ SEBLO

❏ DUMMY_TOP

❏ Provides integration between Siebel Order Entry and Oracle Configurator

f Add the following new entries for Siebel Agreement Integration:

❏ SEBLA

❏ DUMMY_TOP

❏ Provides integration between Siebel Agreement and Oracle Configurator

g Change responsibility to Configurator Administrator.

h Choose the Application to Publication Applicability List and add the applications listed above.

The new applications are available in the shuttle list when creating a Publication.

i Publish the configuration models to the Siebel Application.

For more information, read Oracle Configurator Developer User’s Guide.

3 Set up Siebel Global Preferences to invoke Oracle Configurator.

a In the Siebel application navigate to Administration > Integration > WI Symbolic URL List.

b From the top applet choose Host Administration from the pull-down menu.

c Add a new host entry with the following values:

❏ Host Name = your.host.name:port

❏ Virtual Name = OracleConfigurator

d Select Symbolic URL Administration and add a new record in the top applet with these values:

❏ Name = OracleCfgURL

❏ URL = http://OracleConfigurator/OA_HTML/CfgSebl.jsp

❏ Choose the host name your.host.name:port

❏ Fixup Name = Default

❏ SSO Disposition: IFRAME

e In the bottom applet add the following arguments to the URL:

❏ Name = InitMessage

❏ Required Argument = checked
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❏ Argument Type = Profile Attribute

❏ Argument Value = CZInitMessage

❏ Append as argument = checked

f Add another new argument with these values:

❏ Name = PostRequest

❏ Required Argument = Checked

❏ Argument Type = Command

4 Setup Single Sign-On (SSO) login.

a Set Siebel Profile Option to Launch Oracle Configurator.

b Start the Siebel Client.

c Navigate to Administration > Integration > WI Symbolic URL List.

d From the top applet choose Symbolic URL Administration from the pull-down menu.

e Search for OracleCfgURL

f In the bottom applet add the following new Symbolic URL Arguments:

❏ Name = username, Required = checked, Type = Command, Value = UserLoginId

❏ Name = password, Required = checked, Type = Command, Value = UserLoginPassword 

g Set up the SSO List:

g.1 Use the link to switch to SSO Systems Admin List.

g.2 Search for OracleConfigSSO in the top applet.

g.3 If it is not defined then add a new record with these values:

❏ Name = OracleConfigSSO

❏ Symbolic URL Name = OracleCfgURL

g.4 Add users as needed using this format:

❏ Siebel Login Name = <create_a_name>

❏ Login Name = <oracle name>

❏ Password = <password>

The Oracle CfgSebl.jsp checks for the presence of username and password to determine 
whether to use SSO or to display the Applications log in page.

5 Integrate Siebel Eligibility, Compatibility, and Pricing.

a Set up in Eligibility, Compatibility, and Pricing data in Siebel as needed using product data 
synchronized from the Oracle E-Business Suite.

b The files and workflows necessary to support this integration are deployed as part of the 
installation processes.

6 Set up the ABS Custom Look and Feel:
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a Log in to the Oracle application and select Application Developer.

b Choose Application:Lookups Application Object Library Function.

c Query for: %LOOK%FEEL%

d Add a new lookup value with the following entries in a new row for name, meaning and 
description:

❏ ABS-DESKTOP

❏ ABS Custom Look And Feel

❏ ABS Custom Look And Feel

e Save the record and quit 

f Change responsibility to System Administrator.

g Select Profiles and apply the new look and feel by changing profile value at user or application 
level for profile %LOOK%FEEL%.

Installing Business Processes Execution Language 
Wrapper Packages to Oracle E-Business Suite
The BPEL processes for ATP and Payment Authorization generate wrapper PLSQL packages that need 
to be created in the Oracle EBS database.

To install wrapper packages

1 Run the following commands:

Sqlplus apps/<apps password>@<tns string> 
@CRMINTEG_HOME\BusinessProcesses\ATP\CRMIntegCheckATPSEBL782ToEBS11i10Sync\bpel\ 
XX_BPEL_EBS11I10ATPCHECK_drop.sql

Sqlplus apps/<apps password>@<tns string> 
@CRMINTEG_HOME\BusinessProcesses\ATP\CRMIntegCheckATPSEBL782ToEBS11i10Sync\bpel\ 
XX_BPEL_EBS11I10ATPCHECK.sql

Sqlplus apps/<apps password>@<tns string> 
@CRMINTEG_HOME\BusinessProcesses\PaymentAuthorization\CRMIntegPaymentAuthorization
SEBL782ToEBS11i10Sync\bpel\XX_BPEL_EBS11I10PAYMENTAUTHORI_drop.sql

Sqlplus apps/<apps password>@<tns string> 
@CRMINTEG_HOME\BusinessProcesses\PaymentAuthorization\CRMIntegPaymentAuthorization
SEBL782ToEBS11i10Sync\bpel\XX_BPEL_EBS11I10PAYMENTAUTHORI.sql

Configuring the Siebel CRM Environment
The following setups need to be performed on the Siebel environment.

■ Applying Quick Fix on page 25
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■ Configuring the Customer Integration Point in Siebel CRM on page 25

■ Configuring the Products Integration Point on page 27

■ Configuring the Orders Integration Point on page 30

■ Configuring the Quotes Integration Point on page 34

■ Configuring the Configurator Integration Point on page 36

■ Configuring the Assets Integration Point on page 45

■ Configuring the Application Programming Interfaces on page 46

Applying Quick Fix
You must apply Siebel 7.8.2.4 Quick Fix.

To apply the quick fix

1 Install Siebel Tools 7.8.2.4.

2 Download the Siebel Tools 7.8.2.4 QF19224[Number] from ftp.siebel.com.

ftp.siebel.com:/staging/7.8.2.4sea_19224_QF1406.zip

3 Expand the downloaded file.

4 Navigate to [local directory]\7.8.2.4[19224]QF[Number]\Release\Windows\Client\Siebel_Tools 
and double click on install.exe.

Siebel Tools 7.8.2.4 is patched and the quick fix installed.

5 Navigate to Siebel Tools home directory and open 
ABSCHANGES\ApplicationChanges\SiebelCRMHOR\7.8.2 folder.

The files required for configuration in subsequent sections are organized as per the domains.

In the remaining configuration topics there are references to configuration files. These files are 
located in the above directory.

Configuring the Customer Integration Point in Siebel 
CRM
The following setup steps need to be done for the customer integration point in the specific sequence 
shown.

■ To make repository changes for the customer integration point on page 26

■ To set up for the customer integration point on page 26
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To make repository changes for the customer integration point

1 Log into Siebel tools.

2 Import the SIF files listed in the following table, in the order in which they are listed.

3 Lock the project CRMInteg-Customer Interface.

4 Go to workflows and import the following files:

■ CRMIntegSEBLHORAccountMergeInboundFlow.xml

■ CRMIntegSEBLHORAccountUpdateOutboundFlow.xml

■ CRMIntegSEBLHORContactUpdateOutboundFlow.xml

5 Deploy the workflows.

6 Stop the Siebel server.

7 Compile the locked projects into the server SRF file.

8 Implement the SRF file and restart the Siebel Server.

To set up for the customer integration point

1 Log in to a Siebel application.

2 Navigate to Site Map > Administration > Runtime Events\Events.

3 Query on Object Name = Account

4 Change the sequence of the row with event = WriteRecordUpdated and Object Name = Account 
from -1 to 1.

5 Query on Object Name = Contact.

6 Change the sequence of the row with event = WriteRecordUpdated and Object Name = Contact 
from -1 to 1.

7 Navigate to Site Map > Administration > Business Process > Workflow Processes > Workflow 
Deployment.

8 Query on Name = CRMInteg*.

SIF FILE Name Mode Project

Account.sif Merge Account

AccountAddressListApplet(SCW).sif Merge Account (SCW)

CRMIntegAccountInterfaceIO.sif Merge CRM Integ-Customer Interface

CRMIntegSEBLHORAccountMerge.sif Merge CRM Integ-Customer Interface

CRMIntegSEBLHORAccount.sif Merge CRM Integ-Customer Interface

CRMIntegUpdateAccountSEBL782ToEBS11i1
0Sync.sif

Merge CRM Integ-Customer Interface
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9 Activate the workflows that are queried.

10 Navigate to Site Map > Administration - Runtime Events > Events

11 Click Menu\Reload Runtime Events

12 After reloading the events, Query on Object Name = Account

13 Confirm that there are two rows with Event = WriteRecordUpdated for Object Name = Account; 
one with sequence 1 and the other with sequence -1.

14 Query on Object Name = Contact.

15 Confirm that there are two rows with Event = WriteRecordUpdated for Object Name = Contact; 
one with sequence 1 and the other with sequence -1.

16 If the values are not correct, log out of the application, log back in, activate the workflows again 
and reload the runtime events.

17 Navigate to Site Map > Administration - Web Service> \Inbound Web services.

18 Import the following CRMInteg webservices:

■ CRMIntegSEBLHORAccount.xml

■ CRMIntegSEBLHORAccountMerge.xml

19 Navigate to Site Map > Administration - Web Services > Outbound Web services.

20 Import the following CRMInteg webservice:

■ CRMIntegUpdateAccountSEBL782ToEBS11i10Sync.xml

21 Navigate to the Service Ports applet.

22 Verify the BPEL server name and the client name, and correct them if necessary.

Updates in Siebel CRM have to be done using an account other than an administration account.

Configuring the Products Integration Point
The following setup steps need to be done for the products integration point.

■ To set up for the customer integration point on page 26

■ To deploy workflows on page 29

■ To deploy webservices on page 30

To make repository changes for the products integration point

1 Log into Siebel tools.
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2 Import the files listed in the following table, in the order in which they are listed.

Name Mode Type Project

InternalProduct.sif Merge Business 
Component

Product

ObjectProductImpExpBC.sif Merge Business 
Component

ISS VOD Import Export

InternalProduct.sif Merge Business Object Product

CRMIntegSEBLHORCreateSimple
Product.sif

Overwrite Business 
Service

CRMInteg

CRMIntegSEBLHORFormatMessa
ge.sif

Overwrite Business 
Service

CRMInteg

CRMIntegSEBLHORUpdateInvent
ory.sif

Overwrite Business 
Service

CRMInteg

EAI Siebel Adapter.sif Overwrite Business 
Service

EAI Business Services

ISS Product Authoring ImpExp 
Wrapper.sif

Overwrite Business 
Service

CRMInteg

ISS Prod Def ImpExp - 
External.sif

Overwrite Integration 
Object

CRMInteg

ISS Prod Def ImpExp.sif Overwrite Integration 
Object

ISS VOD Import Export

Simple Product Interface Overwrite Integration 
Object

Product Interface

CRMIntegSEBLHORSimpleProduc
tInboundFlow.xml

Workflow CRMInteg

CRMIntegSimpleProductInbound
WebService.XML

WebService

ISS Admin Product Definitions 
List Applet

Merge Applet ISS Product Admin

Internal Product - ISS Admin Merge Business 
Component

ISS Product Admin

Object Product ImpExp BC Merge Business 
Component

ISS VOD Import Export

CRMCreateComplexMessageInpu
t

Overwrite Business 
Service

CRMInteg

CRMIntegComplexProductEBS11
i10ToSEBL782Sync

Overwrite Business 
Service

CRMInteg
Siebel CRM Integration Pack for Oracle Order Management Implementation 
Guide  

28 



Installation and Configuration ■ Configuring the Siebel CRM Environment
To deploy workflows

1 Log in to Siebel Tools.

2 Navigate to workflows, right click and choose the Import workflow process.

3 Select the following workflows, select the Project as CRMInteg and click OK:

■ CRMIntegSEBLHORSimpleProductInboundFlow

■ CRMIntegComplexProductOutboundFlow

■ CRMIntegSEBLHORComplexProductInboundFlow

4 Query for each workflow above and deploy it.

5 Log in to the Siebel application.

6 Navigate to Administration - Business Processes > Workflow Deployment.

7 For each workflow listed above, query for the workflow and click Activate.

8 Compile the server SRF file.

9 Implement the SRF file and restart the Siebel Server.

CRMIntegSEBLHORFormatMessa
ge

Overwrite Business 
Service

CRMInteg

ISS ComplexProduct Authoring 
ImpExp Wrapper

Overwrite Business 
Service

CRMInteg

CRMIntegComplexProductEBS11
i10ToSEBL782SyncProcessReque
st

Overwrite Integration 
Object

CRMInteg

CRMIntegComplexProductEBS11
i10ToSEBL782SyncProcessRespo
nse

Overwrite Integration 
Object

CRMInteg

ISS Prod Def ImpExp Overwrite Integration 
Objects

ISS VOD Import Export

CRMIntegComplexProductOutbo
undFlow.xml

Workflow CRMInteg

CRMIntegSEBLHORComplexProd
uctInboundFlow.xml

Workflow CRMInteg

CRMIntegComplexProductEBS11
i10ToSEBL782Sync.xml

WebService

CRMIntegComplexProductInbou
ndWebService.XML

WebService

Name Mode Type Project
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To deploy webservices

1 Log in to the Siebel application.

2 Navigate to Administration-WebServices > Outbound Web Services.

3 Click Import and specify the following webservice:

■ CRMIntegComplexProductEBS11i10ToSEBL782Sync

4 Edit the Address to point to the BPEL Integration server.

5 For each of the following webservices:

■ CRMIntegSimpleProductInboundWebService

■ CRMIntegComplexProductInboundWebService

a Click Import.

b Specify the above webservice

c Edit the Address to point to the Siebel server.

6 Click Clearcache.

Configuring the Orders Integration Point
The following setup steps need to be done for the orders integration point.

■ To make repository changes for the orders integration point on page 30

■ To add responsibilities to views on page 31

■ To import XML files on page 31

To make repository changes for the orders integration point

1 Log into Siebel tools.

2 Import the SIF files listed in the following table, in the order in which they are listed.

Name Mode Project

CRMIntegInternalSEBLHOROrderInterfaceIO.sif Overwrite CRMInteg

CRMIntegSEBLHOROrderInterfaceIO.sif Overwrite CRMInteg

CRMIntegSEBLHOROrderInterfaceBS.sif Overwrite CRMInteg

Siebel OrderBS.sif Overwrite Order Interface

Message Set ParserBS.sif Overwrite UAN Utils

Order Entry - Line ItemsBC.sif Merge Order Entry

Order Entry - Line Items (Simple)BC.sif Merge Order Entry

Order Entry - Oracle 11i Line Items View (Sales).sif Merge Oracle Order 11i
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3 Compile the server SRF file.

4 Implement the SRF file and restart the Siebel Server.

To add responsibilities to views

1 Login to the Siebel application.

2 Navigate to Site Map > Application - Administration > Views

3 In the Views applet click the New tab.

4 Add the following view:

■ Order Entry - Oracle 11i Line Items View (RMA)

5 In the Responsibilities applet, add the Administrator responsibility to the view.

To import XML files

1 Log in to Siebel Tools.

2 Navigate to workflows.

3 Right-click and choose Import workflow process.

4 Select the following workflow: CRMIntegSEBLHOROrderCreateOutboundFlow.xml

5 Log in to a Siebel application.

6 Navigate to Administration-WebServices > Outbound Web Services.

Order Entry - Backoffice Integration StatusView.sif Merge CRMInteg

Order Entry - OrdersBC.sif Merge Order Entry

Order Entry - Oracle 11i Line Items View (RMA).sif Merge CRMInteg

Order Entry - Order Form Applet Dashboard 
(RMA).sif

Merge CRMInteg

Order Entry - Line Item List Applet (Sales).sif Merge Order Entry

Order Entry - Line Item List Applet.sif Merge Order Entry

Sales Order Screen.sif Merge Order Entry

Order Entry Screen Merge Order Entry

CRMIntegMACDPerformanceOrder.sif (BO) Merge CRMInteg

CRMInteg MACD Order.sif (BC) Merge CRMInteg

CRMInteg MACD Order Entry.sif (Link) Merge CRMInteg

CRMIntegUpdatePDSOrder.sif (IO) Overwrite CRMInteg

CRMIntegUpdatePDSOrder.sif (BS) Overwrite CRMInteg

Name Mode Project
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7 Click Import and specify the following webservice: CRMIntegSEBLHOROrderCreate.XML

8 Navigate to Administration-WebServices >Inbound Web Services.

9 Query for the Siebel Order inbound webservice: CRMIntegUpdateOrder.XML

10 Edit the Address to point to the Siebel server.

11 Change the webservice status to Active.

Configuring State Model for Orders
To configure a state model, use the following procedure.

To configure a state model for orders

1 Navigate to Site Map.

2 Click Administration - Application.

3 Click State Model.

4 Query for Name = ‘*Order*’.

5 If the query returns a record, make sure it matches the following values; if no record is returned, 
create one with the following values:

■ Name: Sales Order

■ Business Component: Order Entry – Orders

■ Field: Back Office Process Status

6 Click the States tab and create the following entries:

State Name Default
No 
Delete

No 
Update

Restrict 
Transition Description

Created in Back 
Office

Y Y Y Created in Back Office

Creating in 
Back Office

Y Y Y Y Creating in Back Office

Error on 
Creating

Error on Creating

Sync from Back 
Office

Sync from Back Office
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7 Click the Transitions tab and create the following entries:

Configuring State Model for OrderUpdate
To configure a state model, use the following procedure.

To configure a state model for orderUpdate

1 Navigate to Site Map.

2 Click Administration - Application.

3 Click State Model.

4 Click New.

5 For the name of the state model, enter: Sales Order MACD Update Order Line Status.

6 Select the CRMInteg MACD Order Entry - Line Items business component.

This is a custom business object. It appears after the SIF files are imported.

7 Set an activation Date and an expiration Date.

Normally the Expiration Date is left blank.

8 Set the field column to Status.

From State To State Public Rule Field
Rule 
Operator Rule Value

Created in 
Back Office

Sync from 
Back Office

Y Back Office 
Process Status

= 'Created in Back 
Office'

Creating in 
Back Office

Created in 
Back Office

Y Back Office 
Process Status

= 'Creating in Back 
Office'

Creating in 
Back Office

Error on 
Creating

Y Back Office 
Process Status

= 'Creating in Back 
Office'

Creating in 
Back Office

Sync from 
Back Office

Y Back Office 
Process Status

= 'Creating in Back 
Office'

Error on 
Creating

Created in 
Back Office

Y Back Office 
Process Status

= 'Error on Creating'

Error on 
Creating

Sync from 
Back Office

Y Back Office 
Process Status

= 'Error on Creating'

Sync from 
Back Office

Created in 
Back Office

Y Back Office 
Process Status

= 'Sync from Back 
Office'
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9 Click the States tab and create the following entries:

10 Click the Transitions tab and create the following entries:

Configuring the Quotes Integration Point
The following setup steps need to be done for the quotes integration point.

■ To make repository changes for the quotes integration point on page 35

■ To add responsibilities to views on page 35

■ To import XML files on page 35

State Name Default No Delete No Update
Restrict 
Transition Description

Booked Y Y Booked

Complete Y Complete

Pending Y Pending

Picked Y Picked

Shipped Y Shipped

From State To State Public Rule Field Rule Operator Rule Value

Pending Pending Y Status = ‘Pending’

Pending Booked Y Status = ‘Pending’

Pending Picked Y Status = ‘Pending’

Pending Shipped Y Status = ‘Pending’

Pending Complete Y Status = ‘Pending’

Booked Booked Y Status = ‘Booked’

Booked Picked Y Status = ‘Booked’

Booked Shipped Y Status = ‘Booked’

Booked Complete Y Status = ‘Booked’

Picked Picked Y Status = ‘Picked’

Picked Shipped Y Status = ‘Picked’

Picked Complete Y Status = ‘Picked’

Shipped Shipped Y Status = ‘Shipped’

Shipped Complete Y Status = ‘Shipped’

Complete Complete Y Status = ‘Complete’
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To make repository changes for the quotes integration point

1 Log into Siebel tools.

2 Import the SIF files listed in the following table, in the order in which they are listed.

3 Compile the server SRF file.

4 Implement the SRF file and restart the Siebel Server.

To add responsibilities to views

1 Login to the Siebel application.

2 Navigate to Site Map > Application - Administration > Views

3 In the Views applet click the New tab.

4 Add the following view:

■ Quote - Oracle 11i Line Items View (Sales)

5 In the Responsibilities applet, add the Administrator responsibility to the view.

To import XML files

1 Log in to the Siebel application.

2 Navigate to workflows.

3 Right click and choose the Import workflow process.

Name Mode

CRMIntegSEBLHORQuoteInterfaceIO.sif Overwrite

CRMIntegInternalSEBLHORQuoteInterfaceIO.sif Overwrite

CRMIntegSEBLHORQuoteCreateBS.sif Overwrite

Siebel QuoteBS.sif Overwrite

Message Set ParserBS.sif Overwrite

QuoteBC.sif Merge

Quote ItemBC.sif Merge

Quote List Applet.sif Merge

Quote Item List Applet.sif Merge

Quote Form Applet.sif Merge

Quote - Oracle 11i Quote Form Applet.sif Merge

Quote - Oracle 11i Line Items View (Sales).sif Merge

Quotes Screen.sif Merge
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4 Select the following workflow:

■ CRMIntegSEBLHORQuoteCreateOutboundFlow.xml

5 Navigate to Administration-WebServices > Outbound Web Services.

6 Click Import and specify the following webservice:

■ CRMIntegSEBLHORQuoteCreate.xml

7 Navigate to Administration-WebServices >Inbound Web Services.

8 Query for the Siebel Quote inbound webservice:

9 Edit the Address to point to the Siebel server.

10 Change the webservice status to "Active".

Configuring the Configurator Integration Point
The following setup steps need to be done for the configurator integration point.

■ To make repository changes for the configurator integration point on page 36

■ To change runtime configuration on page 40

■ To add Siebel custom applications to Oracle applications on page 43

■ To copy Config Web Service setup on page 43

■ To copy Config Data Map setup on page 44

■ To set up DoCompression Parameters on page 44

To make repository changes for the configurator integration point
Note: Import the SIF files in the same order as listed below. When importing SIF files always choose 
the conflict resolution as Merge.

1 Log in to Siebel tools.

2 Create a new project named Oracle Configurator Integration and lock it.

3 In the Object Explorer pane, select the Tables object.

4 For each of the following files, repeat these steps:

File Name Record to Select

InternalProductTBL.sif S_PROD_INT

eim_prod_int1_hor.sif S_PROD_INT

QuoteItemTBL.sif S_QUOTE_ITEM

OrderItemTBL.sif S_ORDER_ITEM

AgreementItemTBL.sif S_AGREE_ITEM
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a Import the file.

b Select the record and click Apply.

c In the resulting dialog box enter Table Owner user name and password, and choose the correct 
datasource.

d Click Apply.

This creates or alters the physical database and the operation must complete successfully. If 
it does not then contact your database administrator.

5 In the Object Explorer pane select the Business Component object.

6 Import the following files, using Merge as the conflict resolution, in the order listed.

■ InternalProduct.sif

■ QuoteItemBC.sif

■ QuoteItem(Simple)BC.sif

■ OrderEntry-LineItemsBC.sif

■ OrderEntry-LineItems(Simple)BC.sif

■ FSAgreementItemBC.sif

■ FSAgreementItem(Simple)BC.sif

■ CZProductBC.sif

■ CZVbcBC.sif

■ TemplateItem(Simple)BC.sif

■ TemplateItemBC.sif

7 In the Object Explorer pane select the Business Object object.

8 Import the following files, using Merge as the conflict resolution, in the order listed.

■ InternalProductBO.sif

■ QuoteBO.sif

■ OrderEntry(Sales)BO.sif

■ ServiceAgreementBO.sif

■ TemplateBO.sif

9 In the Object Explorer pane select the Integration Object object.

10 Import the following files, using Merge as the conflict resolution, in the order listed.

■ CZQuoteIntegObjIO.sif

■ CZOrderEntryIntegObjIO.sif

■ CZServiceAgreementIntegObjIO.sif

■ CZTemplateIntegObjIO.sif

■ CRMIntegGetEBSUserRespProcessRequestIO.sif
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■ CRMIntegGetEBSUserRespProcessResponseIO.sif

■ CZIntegGetLanguageSyncProcessRequestIO.sif

■ CZIntegGetLanguageSyncProcessResponseIO.sif

■ CZIntegCopyConfigSEBL782ToEBS11i10SyncProcessRequestIO.sif

■ CZIntegCopyConfigSEBL782ToEBS11i10SyncProcessResponseIO.sif

11 In the Object Explorer pane select the Business Service object.

12 Import the following files, using Merge as the conflict resolution, in the order listed.

■ CZSessionManagementBS.sif

■ CZSessionCacheBS.sif

■ CZIntegCopyConfigServiceBS.sif

■ CZIntegGetLanguageSyncBS.sif

■ CZIntegGetOracleUserRespOULangBS.sif

■ CZIntegPrepareIntegrationObjectsBS.sif

■ ISSCopyServiceBS.sif

■ ISSTemplateServiceBS.sif

■ CRMIntegGetEBSUserRespBS.sif

■ CZIntegCopyConfigSEBL782ToEBS11i10SyncBS.sif

13 In the Object Explorer pane select the Workflow Process object.

14 Import the following files, using Merge as the conflict resolution, in the order listed.

■ OracleConfiguratorLoadWF.xml

■ CZReturnWF.xml

■ CZPSPInterfaceWF.xml

■ OracleVerifyItem(Quote)WF.xml

■ OracleVerifyItem(Order)WF.xml

■ OracleVerifyHeader(Quote)WF.xml

■ OracleVerifyHeader(Order)WF.xml

■ OracleVerifyComplexProductAll(Order)WF.xml

■ OracleVerifyComplexProductAll(Quote)WF.xml

15 In the Object Explorer pane select the Web Template object.

16 Import the following files, using Merge as the conflict resolution, in the order listed.

■ CZViewBasic(JS)WT.sif

■ CZAppletWT.sif

17 Copy the following Web Template files to the Siebel enterprise server's WEBTEMPL directory:
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■ CZView.swt

■ CZConfigurator.swt

18 Copy the following HTML file to the Siebel web server DOCROOT\Public\<lang> directory:

■ CZReturn.html

19 In the Object Explorer pane select the Applet object.

20 Import the following files, using Merge as the conflict resolution, in the order listed.

■ CZAppletAPL.sif

■ QuoteItemListAppletAPL.sif

■ OrderEntry-LineItemListApplet(Sales)APL.sif

■ FSAgreementItemListAppletAPL.sif

■ QuoteCatalogProductListApplet-AddtoCartAPL.sif

■ QuoteCatalogAdminCatalogCategoryProductListAppletAPL.sif

■ SalesOrderCatalogProductListApplet-AddtoCartAPL.sif

■ ProductTemplateItemListAppletAPL.sif

■ AgreementDetailAppletAPL.sif

■ OrderEntry-LineItemListApplet(Sales)-ShortAPL.sif

■ QuoteItemListApplet-ShortAPL.sif

■ QuoteCatalogTemplateListAppletAPL.sif

■ QuoteCatalogTemplateItemListAppletAPL.sif

■ ProductTemplateListAppletAPL.sif

■ OrderEntry-LineItemListAppletAPL.sif

■ OrderEntry-OrderFormAppletDashboard(RMA)APL.sif

■ QuoteFormAppletAPL.sif

■ QuoteListAppletAPL.sif

21 In the Object Explorer pane select the View object.

22 Import the following files, using Merge as the conflict resolution, in the order listed.

■ CZRuntimeInstanceView(JS)VW.sif

■ CZRuntimeInstanceView(J)-Order(Sales)VW.sif

■ CZRuntimeInstanceView(JS)-AgreementVW.sif

■ CZRuntimeInstanceView(JS)-FavoritesVW.sif

23 In the Object Explorer pane select the Screen object.

24 Import the following files, using Merge as the conflict resolution, in the order listed.

■ QuotesScreenSCN.sif
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■ SalesOrderScreen.sif

■ AgreementScreenSCN.sif

■ ISSUnifiedAdministrationScreenSCN.sif

25 Compile the server SRF file.

26 Some of the applet changes contain browser scripts that need to be moved to the Siebel web 
server's DOCROOT\Public\<lang> directory.

27 Navigate to View > Options > Scripting tab.

28 Set the correct folder for the script compilation directory.

29 Compile the artifacts to the enterpriser server SRF and restart Siebel server.

30 Edit the Siebel application’s CFG file.

31 In the SWE section add ClientBusinessServiceNN = "CZSessionManagement" (Where NN - a 
continuous sequence number).

This exposes the CZSessionManagement business service to the client side scripts.

32 Restart Siebel server.

To change runtime configuration

1 Log in to the Siebel application.

2 Navigate to site map > Administration Business process > Repository workflow process.

3 In the top applet query for the workflows imported above and activate them.

4 Make sure they are in active state by querying in the bottom applet.

5 Navigate to site map > Administration Order Management > Signals.

6 Query for the Signal Customize.

7 Lock the signal record and click Workspace.

8 Change the service name to Oracle Configurator Load.

9 Navigate back to the Signals view and click Release New Version.

10 Query for the Signal QuotesAndOrdersValidate.

11 Lock the signal record and click Workspace.

12 Replace the Siebel Verification with Oracle Batch Validate.

13 Change the following records with sequence #2.

■ Mode = Quote, Instance Type = Line Item - Change Service Name column to "Oracle Verify 
Item (Quote)"

■ Mode = Order, Instance Type = Line Item - Change Service Name column to "Oracle Verify 
Item (Order)"

■ Mode = Quote, Instance Type = Header - Change Service Name column to "Oracle Verify 
Header(Quote)"
Siebel CRM Integration Pack for Oracle Order Management Implementation 
Guide  

40 



Installation and Configuration ■ Configuring the Siebel CRM Environment
■ Mode = Order, Instance Type = Header - Change Service Name column to "Oracle Verify 
Header (Quote)"

14 Navigate back to Signals view and click Release New Version to release a new version of the 
signal.

15 Navigate to site map > Administration Runtime Events > Events.

16 Click Menu > Reload Runtime Events.

17 Navigate to site map > Administration - Application > Views.

18 Click New to create the following new views:

■ CZRuntimeInstanceView (JS)

■ CZRuntimeInstanceView (JS) - Agreement

■ CZRuntimeInstanceView (JS) - Order (Sales)

19 For each view assign the appropriate responsibility.

20 Navigate to site map > Administration - Integration > WI Symbolic URL List.

21 In the top applet choose Host Administration from the menu.

22 Add the following new host entry:

■ Host Name: <Oracle EBIZ host name:port number>
Example: qapache.us.oracle.com:3710 

■ Virtual Name: OracleConfigurator

23 Select Symbolic URL Administration and add the following new record in the top applet:

■ Name: OracleCfgURL

NOTE: This symbolic name is very important because server side business component code 
relies on this name.

■ URL: http://OracleConfigurator/OA_HTML/CfgSebl.jsp

■ Host name
Example qapache.us.oracle.com:3710

■ Fixup Name: Default

■ SSO Disposition: IFRAME
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24 In the bottom applet create the following records:

Records 3 and 4 are for use with Single Sign On (SSO). If SSO is not used in your implementation 
then the Siebel application users need Oracle login credentials.

25 Select "SSO Systems Admin List" and add a record in the top applet:

■ System Name: OracleConfigSSO

■ Symbolic URL Name: OracleCfgURL

■ Description: Logs in to the Oracle Configurator

26 In the bottom applet "SSO System Users" add records for the Siebel users.

NOTE: The Siebel usernames must be paired with Oracle login credentials.

For example:

■ Siebel Login Name: sadmin

■ Login Name: operations

■ Password: welcome

27 Query the following workflow names and make sure all matching workflows are activated:

■ Account - New Quote

■ Account - New Order

■ Goto*

■ PSP*

■ Product Compatibility*

■ Product Eligibility*

■ Product Reco*

■ *Pric*

■ Compatibility Multiple Popup Workflow

■ Config*

■ Check*

Field Record 1 Record 2 Record 3 Record 4

Name InitMessage PostRequest username password

Req Arg Checked Checked Checked Checked

Argument Type Profile Attribute Command Command Command

Argument Value CZInitMessage PostRequest UserLoginId UserLoginPassw
ord

Append as 
argument

Checked Clear Checked Checked
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Several custom Oracle Applications need to be created to allow models to be accessed from Siebel. 
These custom applications are used during the publication phase of Oracle Configurator Model 
development cycle.

To add Siebel custom applications to Oracle applications

1 Log in to Oracle EBS with an account that has System Administrator responsibility.

2 Choose Application > Register.

Forms starts up. The form page for Applications > Register should be displayed. If not, navigate 
to the form.

3 Create the following new entries:

The short names appear in the Configurator Developer when the configuration model is 
published.

4 Change responsibility to Oracle Configurator Administrator.

5 For each of the applications listed in the previous table, complete these steps:

a Choose Concurrent Programs > Schedule.

b Enter a program name of: Add Application to Publication Applicability List, or choose this 
program from the list of values.

c Click Next, and then enter one of the applications listed in the table.

d For example, enter Siebel Quote Integration.

e Click Next several times, and then click Submit to run the concurrent program.

When the concurrent programs you have scheduled have completed successfully, the new 
applications are available in Configurator Developer when publishing configuration models. For 
details about developing configuration models and making them available to hosting applications, 
refer to Oracle Configurator documentation.

To copy Config Web Service setup

1 Log in to the Siebel application.

2 Navigate to site map > Administration Web Services > Outbound Web Services.

Application
Short 
Name Basepath Description

Siebel Quote 
Integration

SEBLQ DUMMY_TOP Provides integration between Siebel Quote 
and Oracle Configurator

Siebel Order Entry 
Integration

SEBLO DUMMY_TOP Provides integration between Siebel Order 
Entry and Oracle Configurator

Siebel Agreement 
Integration 

SEBLA DUMMY_TOP Provides integration between Siebel 
Agreement and Oracle Configurator
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3 Click Import and import the following files:

■ CZIntegCopyConfigSEBL782ToEBS11i10Sync.XML

■ CZIntegGetLanguageSync.XML

■ CRMIntegGetEBSUserResp.XML

4 Change the IP Address on the Service Ports (middle applet) for each of the above web services 
to be the address of the BPEL server.

To copy Config Data Map setup

1 Log in to the Siebel application.

2 Navigate to site map > Administration - Application > Data Map Administration.

3 For the following Data Maps, add three columns 'External Configurator Reference 1','External 
Configurator Reference 2', 'External Configurator Reference 3' to both the Source and the 
Destination Column in 'Data Map Field' section for the 'Data Map Component' specified in the 
parenthesis below.

■ AutoAgreement(Data Map Component:Line Item)

■ AutoAgreeFromOrder(Data Map Component Name:Line Items)

■ CopyOrder(Data Map Component Name:Line Item)

■ CopyQuote(Data Map Component Name:Line Item)

■ OrderToTemplate(Data Map Component Name:Line Item)

■ QuoteToSalesOrder(Data Map Component Name:Line Item)

■ QuoteToServiceOrder(Data Map Component Name:Line Item)

■ QuoteToTemplate(Data Map Component Name:Line Item)

■ ReviseAgreement(Data Map Component Name:Line Item)

■ ReviseOrder(Data Map Component Name:Line Item)

■ ReviseQuote(Data Map Component Name:Line Item)

■ TemplateToOrder(Data Map Component Name:Line Item)

■ TemplateToQuote(Data Map Component Name:Line Item)

To set up DoCompression Parameters

1 Stop the Siebel Server.

2 Backup the following file:

■ eapps.cfg

3 Edit a copy of eapps.cfg using Notepad. 

NOTE: Do not use Wordpad as it causes incorrect characters to be added to the file.

4 In the [defaults] section set the DoCompression parameter as follows:
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■ DoCompression=FALSE

5 Restart the Siebel Server.

NOTE: Restarting the Siebel Server software is not sufficient, the computer running the Siebel 
Server software must be restarted.

Notes about Copying Configurable Items
When testing a copy of a configurable item at the line level, select the line that was copied at the 
line level to view the results of the copy.

If you copied a configurable item at the header level, select a different screen or applet and then 
return to the original screen or applet to force a redisplay of the results.

Configuring the Assets Integration Point
The following setup steps need to be done for the asset integration point.

■ To change the repository on page 45

■ To set up the client software on page 46

To change the repository

1 Log into Siebel Tools.

2 Import the SIF files listed in the following table.

3 Lock the project CRMInteg-Asset Interface.

4 Shut down the Siebel server.

5 Compile the project CRMInteg-Asset Interface and Asset Management into the server SRF file.

6 Restart the Siebel server.

SIF File Name
Mode of 
Import Project

AssetManagementBO.sif Merge Asset Management

AssetManagementInterfaceBO.sif Merge Asset Management

AssetMgmt -AssetBC.sif Merge CRMInteg-Asset Interface

AssetMgmtAssetHeaderBC.sif Merge CRMInteg-Asset Interface

CRMIntegAssetInterfaceBS.sif Overwrite CRMInteg-Asset Interface

CRMIntegAssetInterfaceIO.sif Overwrite CRMInteg-Asset Interface
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To set up the client software

1 Log in to the Siebel application.

2 Navigate to Site Map > Administration - Web Services > Inbound Web services.

3 Import the CRMInteg webservices using the following file:

■ CRMIntegSEBLHORAsset.xml

Configuring the Application Programming Interfaces
Import the specified files to configure the repository.

To change the repository

1 Log into Siebel Tools.

2 Import the SIF files for Credit Check as listed in the following table.

SIF File Name
Mode of 
Import Project

CRMIntegCheckCreditSEBL782ToEBS11i10SyncBS.sif Overwrite CRMInteg

CRMIntegInternalSEBLHOROrderInterfaceIO.sif Overwrite CRMInteg

CRMIntegSEBLHOROrderInterfaceIO.sif Overwrite CRMInteg

Genesis Display MessageBS.sif Overwrite CRMInteg

Genesis Order Payment HandlerBS.sif Overwrite CRMInteg

GenesisErrorHandlerBS.sif Overwrite CRM-UCM 
Integration

GenesisErrorMessages.sif Merge CRM-UCM 
Integration

Order Entry - Line ItemsBC.sif Merge Order Entry

Order Entry - OrdersBC.sif Merge Order Entry

Order Entry - Requested Schedule Lines (Deep)BC.sif Merge ATP

Siebel OrderBS.sif Overwrite Order Interface
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3 Import the SIF files for Payment Authorization as listed in the following table.

4 Import the SIF files for ATP Check as listed in the following table.

5 Import the SIF files for Shipping Charges as listed in the following table.

SIF File Name
Mode of 
Import Project

CRMIntegInternalSEBLHOROrderInterfaceIO.sif Overwrite CRMInteg

CRMIntegPaymentAuthorizationSEBL782ToEBS11i10Syn
cBS.sif

Overwrite CRMInteg

CRMIntegSEBLHOROrderInterfaceIO.sif Overwrite CRMInteg

Genesis Display MessageBS.sif Overwrite CRMInteg

Genesis Order Payment HandlerBS.sif Overwrite CRMInteg

GenesisErrorHandlerBS.sif Overwrite CRM-UCM 
Integration

Order Entry - Line ItemsBC.sif Merge Order Entry

Order Entry - OrdersBC.sif Merge Order Entry

Order Entry - Requested Schedule Lines (Deep)BC.sif Merge ATP

Siebel OrderBS.sif Overwrite Order Interface

Message Set ParserBS.sif Overwrite UAN Utils

SIF File Name
Mode of 
Import Project

ATP Check Interface Request - OrdersIO.sif Overwrite ATP

ATP Check InterfaceIO.sif Overwrite Order Interface

CRMIntegCheckATPSEBL782ToEBS11i10SyncBS.sif Overwrite CRMInteg

Genesis Display MessageBS.sif Overwrite CRMInteg

GenesisErrorHandlerBS.sif Overwrite CRM-UCM Integration

SIF File Name
Mode of 
Import Project

CRMIntegInternalSEBLHOROrderInterfaceIO.sif Overwrite CRMInteg

CRMIntegSEBLHOROrderInterfaceIO.sif Overwrite CRMInteg

CRMIntegShippingChargesSEBL782ToEBS11i10SyncBS.sif Overwrite CRMInteg

Genesis Display MessageBS.sif Overwrite CRMInteg
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6 Import the workflows listed in the following table:

7 Import the Outbound Web services listed in the following table:

8 For each of the above outbound web services edit the Address to point to the BPEL Integration 
server.

GenesisErrorHandlerBS.sif Overwrite CRM-UCM 
Integration

Order Entry - Line ItemsBC.sif Merge Order Entry

Order Entry - Order SubTotal Form Applet (Sales)Applet.sif Merge Order Entry

Order Entry - OrdersBC.sif Merge Order Entry

Order Entry - Requested Schedule Lines (Deep)BC.sif Merge ATP

Siebel OrderBS.sif Overwrite Order 
Interface

MessageSetParserBS.sif Overwrite UAN Utils

GenesisOrderWeightHandler.sif Overwrite CRMInteg

Workflow File Purpose

CRMIntegSEBLHORCreditCheckOutboundFlow.xml Credit Check

CRMIntegSEBLHORPaymentsAuthorizationOutboundFlow.xml Payment Authorization

CRMIntegSEBLHORATPCheckOutboundFlow.xml ATP Check

CRMIntegSEBLHORShippingChargesOutboundFlow.xml Shipping Charges

Workflow File Purpose

CRMIntegCheckCreditSEBL782ToEBS11i10Syncexp.xml Credit Check

CRMIntegPaymentAuthorizationSEBL782ToEBS11i10Syncexp.xml Payment Authorization

CRMIntegCheckATPSEBL782ToEBS11i10Syncexp.xml ATP Check

External ATP Check.xml ATP Check

CRMIntegShippingChargesSEBL782ToEBS11i10Syncexp.xml Shipping Charges

SIF File Name
Mode of 
Import Project
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Configuring Oracle E-Business Suite 
Application Server
This section contains integration setup steps that are common across all modules.

■ Setting Up Asynchronous Error Handling on page 49

■ Defining Connection Pools on page 50

■ Defining Datasources on page 51

■ Defining Adapter Connection Factories on page 52

■ Setting up Common Functions on page 53

■ Importing ID Cross-Reference Seed Data on page 54

■ Creating Mapped Siebel Business Units for Oracle Operating Units (Organizations) on page 55

■ Validating and Loading Data Value Maps on page 61

Setting Up Asynchronous Error Handling
The CRMIntegErrorHandlerService requires a database to store information. Connect to the database 
using SQL client and perform the following configuration.

To set up asynchronous error handling

1 Create a tablespace (Optional; you can use existing table spaces for ERRORADMIN user).

CREATE SMALLFILE TABLESPACE "ERRORHANDLING" DATAFILE 
'D:\ORACLEDB10G\PRODUCT\10.2.0\ORADATA\GENESIS0\ERRORHANDLING.DAT' SIZE 100M 
AUTOEXTEND ON NEXT 1024K MAXSIZE UNLIMITED LOGGING EXTENT MANAGEMENT LOCAL SEGMENT 
SPACE MANAGEMENT AUTO; 

2 Create a user.

CREATE USER ERRORADMIN
IDENTIFIED BY VALUES '1ED1F1122BB2CF2E'
DEFAULT TABLESPACE ERRORHANDLING
TEMPORARY TABLESPACE TEMP
PROFILE DEFAULT
ACCOUNT UNLOCK;

3 Grant user privileges.

GRANT ALTER ANY TABLE TO ERRORADMIN;
GRANT ALTER ANY TYPE TO ERRORADMIN;
GRANT CREATE SESSION TO ERRORADMIN;
GRANT CREATE SYNONYM TO ERRORADMIN;
GRANT CREATE ANY TABLE TO ERRORADMIN;
GRANT CREATE ANY TYPE TO ERRORADMIN;
GRANT DROP ANY TABLE TO ERRORADMIN;
GRANT CREATE ANY TYPE TO ERRORADMIN;
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GRANT UNLIMITED TABLESPACE TO ERRORADMIN;
GRANT INSERT ANY TABLE TO ERRORADMIN;
GRANT SELECT ANY TABLE TO ERRORADMIN;
GRANT UPDATE ANY TABLE TO ERRORADMIN;

4 Create ERROR_DATABASE table in the ERRORADMIN schema.

CREATE TABLE ERROR_DATABASE
(

CALLINGPROCESSNAME        VARCHAR2(60 BYTE),
CALLINGPROCESSINSTANCEID  VARCHAR2(10 BYTE),
FAULTTEXT                 VARCHAR2(1000 BYTE),
FAULTSTACK                VARCHAR2(1000 BYTE),
FAULTCONTEXT              VARCHAR2(200 BYTE),
PROCESSINPUTPAYLOAD       CLOB

);

Defining Connection Pools
You need to define connection pools as described in the following procedure.

To define connection pools

1 From the Oracle SOA Suite main page click the link for Application Server Control.

2 Log in as an administrative user.

3 Under All Application Servers, click the SOA application server name.

4 Click the OC4J J2EE container name.

5 Click the Administration tab.

6 Navigate to Administration Tasks > Services > JDBC Resources, and then click Go to Task.

7 Under Connection Pools, click Create.

8 From the Application picklist, choose the appropriate domain (for example: default).

9 For each of the connection pools listed in the following table, complete these steps:

Connection Pool 
Name Description

OracleEBSConnPool Database connection pointing to the Oracle E-Business Suite APPS 
Schema. You need the host, port, and service-name for the Oracle 
E-Business Suite Database, and the user name and password for the 
APPS schema.
Siebel CRM Integration Pack for Oracle Order Management Implementation 
Guide  

50 



Installation and Configuration ■ Configuring Oracle E-Business Suite Application Server
a Under Connection Pool Type, choose New Connection Pool.

b Click Continue.

c Enter the name of the connection pool.

d Under URL, click on JDBC URL and enter the appropriate host:port:service name for this 
connection. For example:

jdbc:oracle:thin:@ap6129rt.us.oracle.com:1625:c10odss1

e Under Credentials, enter the schema username and password for this connection.

f Click Finish.

g Test the connection by clicking Test Connection for the Connection Pool you created.

h Click Test.

If successful, a confirmation message appears.

Defining Datasources
The following datasources need to be defined using Oracle Enterprise Manager.

To define datasources

1 Log in to Oracle Enterprise Manager as an administrative user.

2 Click oc4j_soa > Click on Administration > JDBC Resources

3 Create a connection pool corresponding to the datasource required.

ErrorDBConnPool Database connection pointing to the schema under which the ERROR 
Logging tables have been created. For more information, read Setting 
Up Asynchronous Error Handling on page 49. You need the host, port, 
and service-name for the Error Logging DB, and the user name and 
password for the ERRORADMIN schema.

CRMIntgConnPool Database connection pointing to the schema under which the cross-
reference tables have been created (previous step). You need the host, 
port, and service-name for the cross-reference database, and the user 
name and password for the schema under which the ross-reference 
tables have been created.

Connection Pool 
Name Description
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4 Create datasources pointing to the above connection as detailed in the following table.

Defining Adapter Connection Factories
The Siebel CRM Integration Pack for Oracle Order Management needs data sources for the adapters.

To create adapter connection factories

1 From the Oracle SOA Suite main page click link for Application Server Control.

2 Log in as an administrative user.

3 Under All Application Servers, click on your SOA application server name.

4 Click on your OC4J J2EE container name.

5 Click Applications tab.

6 Click domain name.

7 Configure AppsAdapter

a Click AppsAdapter module.

b Click Connection Factories

c Click Create above JNDI Location.

d Leave default for Connection Factory Interface and Click Continue.

e For JNDI location enter: eis/Apps/OracleEBSDataSource.

f Under Connection Pooling select No Connection Pool.

g Under Configuration Properties, enter dataSource as loc/OracleEBSDataSource and 
xADataSource as jdbc/OracleEBSDataSource.

h Click Finish.

Datasource JNDI Name Details

OracleEBSDataSource loc/OracleEBSDataSource

jdbc/OracleEBSDataSource

Datasource pointing to the Oracle 
EBS Datasource

CRMIntgDataSource jdbc/crmintg A datasource pointing to a xrefuser 
on the 10.1.3 Dehydration Database.

ErrorDB loc/ErrorDB

jdbc/ErrorDB

A datasource pointing to error 
database.

An addition xref data source is needed in case when xref_data table has not been created 
under oraesb or orabpel user name.

xref jdbc/xref A datasource pointing to a xrefuser 
on the 10.1.3 Dehydration Database.
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8 Configure AQ Adapter

a Click AqAdapter module.

b Click Connection Factories

c Click Create above JNDI Location.

d Leave default for Connection Factory Interface and Click Continue.

e For JNDI location enter: eis/AQ/OracleEBSDataSource.

f Under Connection Pooling select No Connection Pool.

g Under Configuration Properties, enter dataSource as loc/OracleEBSDataSource and 
xADataSource as jdbc/OracleEBSDataSource.

h Click Finish.

9 Configure DB Adapter

a Click DbAdapter module.

b Click Connection Factories

c Click Create above JNDI Location.

d Leave default for Connection Factory Interface and Click Continue.

e For JNDI location enter: eis/DB/OracleEBSDataSource.

f Under Connection Pooling select No Connection Pool.

g Under Configuration Properties, enter dataSource as loc/OracleEBSDataSource and 
xADataSource as jdbc/OracleEBSDataSource.

h Click Finish.

i Click Create above JNDI Location.

j Leave default for Connection Factory Interface and Click Continue.

k For JNDI location enter eis/DB/ErrorDB.

l Under Connection Pooling, select No Connection Pool.

m Under Configuration Properties, enter dataSource as loc/ErrorDB and xADataSource as jdbc/

n ErrorDB.

o Click Finish.

Setting up Common Functions
Complete the following procedures.

To set up common functions

1 These steps should be run from the location where the integration files have been placed.
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2 Change directory to CRMINTG_HOME/SharedComponents/Utility/CommonFunctions.

3 Using SQLPlus connect to the cross-reference schema, and run this file:

create_crmintgCommon_schema.sql

4 Change directory to <SOA_HOME>\bpel\system\classes.

5 Extract the crmintg-common.jar file from the build folder to <SOA_HOME>\bpel\system\classes 
with folder structure using the following command:

jar xvf  CRMINTG_HOME/SharedComponents/Utility/CommonFunctions/crmintg-common.jar

6 Make a backup copy of <SOA_HOME>\bpel\system\config\xpath-functions.xml.

7 Open CRMINTG_HOME/SharedComponents/Utility/CommonFunctions/crmintg-xpath-
functionEntries.txt from build folder and copy the contents of this file to the end of 
<SOA_HOME>\bpel\system\config\xpath-functions.xml file.

NOTE: This content should go inside the top level element (bpel-xpath-functions), not after that.

To set up common objects

1 Locate the following directory:

BusinessProcesses/xmllib/SEBLOrderCapIntegPkEBSOM 

2 Copy it using the following command:

a For Windows:

cd %CRMINTG_HOME%\BusinessProcesses\xmllib
copy -r * %SOA_HOME%\bpel\system\xmllib

b For Unix:

cd $CRMINTG_HOME/BusinessProcesses/xmllib
cp -r * $SOA_HOME/bpel/system/xmllib

Importing ID Cross-Reference Seed Data
Complete the following procedure.

To import the ID cross-reference table and column definitions

1 Open a command prompt or shell.

2 Change directory to <SOA_HOME>\integration\esb\bin

3 Set the following environment variables.

■ - OC4J_USERNAME

■ - OC4J_PASSWORD

4 Execute the following command at <SOA_HOME>\integration\esb\bin:
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a For Windows:

xreftool -f 
%CRMINTG_HOME%\SharedComponents\Utility\CommonFunctions\crmintg_seed_data.txtcr
mintg_seed_data.txt

b For Linux:

./xreftool.sh -f $CRMINTG_HOME/SharedComponents/Utility/CommonFunctions/
crmintg_seed_data.txtcrmintg_seed_data.txt

Creating Mapped Siebel Business Units for Oracle 
Operating Units (Organizations)
Business Units need to be created in Siebel CRM for every operating unit in Oracle.

To create business units

1 Identify and collect information about the operating units in Oracle EBS that need to be mapped 
to Siebel CRM for your business.

a For every operating unit (Organization) in Oracle EBS, gather the following information:

■ Name and ID and Code

■ Location

■ Address

For example: Name: Vision Operations, Code: V1, ID: 204

2 Create Business Units in Siebel CRM.

a Log in to the Siebel Callcenter client.

b Navigate to Site Map > Administration - Group > Organizations.

c For each operating unit you identified:

❏ In the Organizations applet click New.

❏ Enter the exact name as in Oracle EBS and save.

❏ Highlight the record and then click Help > About Record on the menu bar to check the 
row number.

❏ Note this row number and the Oracle operating unit it corresponds to for creating the 
cross-reference in subsequent step.

3 Create Inventory Locations in Siebel CRM

For detailed description of Inventory Location setup refer to the Siebel Bookshelf.

a Login to the Siebel Service client.

b Navigate to Site Map > Inventory > Inventory.

c For each inventory location that you are mapping in from Oracle EBS, do the following:
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❏ Create New and complete the required fields.

❏ Name is the name of the warehouse/inventory organization in Oracle EBS, concatenated 
with the organization code. For example:
Vision Operation is a inventory organization in Oracle EBS with a code of V1, so in Siebel 
CRM the entry is:
Vision Operations:V1

NOTE: Name must be entered exactly as shown in the above example.

❏ Set the Type as appropriate for your installation. 

❏ Associate a position that should has access to this Inventory Location.

❏ Note the ROWID of the inventory location created for use in the creation of the cross-
reference as described below.

4 Create ORGANIZATION mapping XML, and load into cross-reference.

a Create an XML file to map Oracle operating units to Siebel Business units. The format of the XML 
file is as follows:

<xref xmlns="http://xmlns.oracle.com/xref">
<table name=" ORGANIZATION">

<columns>
<column name="SIEBEL78_01"/>
<column name="ORACLE11I10_01"/>

</columns>
<rows>

<row>
<cell colName="SIEBEL78_01">  [1st Siebel BU ID eg: 42-4YGUO] </cell>
<cell colName="ORACLE11I10_01">[1st Oracle OU ID. Eg: 888]</cell>

</row>
<row>

<cell colName="SIEBEL78_01">  [2nd Siebel BU ID eg: 42-4YGUO] </cell>
<cell colName="ORACLE11I10_01">[2nd Oracle OU ID. Eg: 888]</cell>

</row>
… repeat for each mapping

</rows>
</table>

</xref>

b Save the above XML files in a directory on the machine where SOA Suite is installed.

c Import the XML into the cross-reference tables by opening a command prompt or shell.

d Change directory to <SOA_HOME>\integration\esb\bin.

e Set the following environment variables:

❏ OC4J_USERNAME

❏ OC4J_PASSWORD

❏ CRMINTG_DB_URL=<DB Url for x-ref database>

❏ CRMINTG_DB_USER=<DB username for x-ref schema>

❏ CRMINTG_DB_PASSWORD=<DB password for x-ref schema>
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❏ GUID_GENERATOR=oracle.crmintg.common.xpath.CRMIntgGUIDGenerator

f Run the following command to import the ORGANIZATION XML created in the previous step into 
cross-reference.

For Windows:

xrefimport -file <import xml file name with full path> -generate COMMON

For Linux:

./xrefimport.sh -file <import xml file name with full path> -generate COMMON

5 Create INVENTORY mapping XML, and load into cross-reference.

a Create an XML file to map Oracle operating units to Siebel Inventory.

The format of the XML file is:

<xref xmlns="http://xmlns.oracle.com/xref">
<table name=" INVENTORY LOCATION">

<columns>
<column name="SIEBEL78_01"/>
<column name="ORACLE11I10_01"/>

</columns>
<rows>

<row>
<cell colName="SIEBEL78_01">  [1st Siebel Inv Loc ID eg: 42-4YGUO] </

cell>
<cell colName="ORACLE11I10_01">[1st Oracle OU ID. Eg: 888]</cell>

</row>
<row>

<cell colName="SIEBEL78_01">  [2nd Siebel Inv Loc ID eg: 42-4YGUO] </
cell>

<cell colName="ORACLE11I10_01">[2nd Oracle OU ID. Eg: 888]</cell>
</row>
… repeat for each mapping

</rows>
</table>

</xref>

b Save the above XML files in a directory on the machine where SOA Suite is installed.

c Import the XML into the cross-reference tables, by opening a command prompt or shell.

d Change directory to <SOA_HOME>\integration\esb\bin.

e Set the following environment variables:

❏ OC4J_USERNAME

❏ OC4J_PASSWORD

❏ CRMINTG_DB_URL=<DB Url for x-ref database>

❏ CRMINTG_DB_USER=<DB username for x-ref schema>

❏ CRMINTG_DB_PASSWORD=<DB password for x-ref schema>

❏ GUID_GENERATOR=oracle.crmintg.common.xpath.CRMIntgGUIDGenerator
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f Run the following command to import the INVENTORY LOCATION XML created in the previous 
step into cross-reference.

For Windows:

xrefimport -file <import xml file name with full path> -generate COMMON

For Linux:

./xrefimport.sh -file <import xml file name with full path> -generate COMMON

6 Create USER mapping XML, and load into cross-reference.

a Create an XML file to map Oracle users to Siebel users that are used in the integration.

The format of the XML file is:

<xref xmlns="http://xmlns.oracle.com/xref">
<table name=" USERS">

<columns>
<column name="SIEBEL78_01"/>
<column name="ORACLE11I10_01"/>

</columns>
<rows>

<row>
<cell colName="SIEBEL78_01">  [1st Siebel user name eg: SADMIN] </

cell>
<cell colName="ORACLE11I10_01">[1st Oracle OU ID. Eg: OPERATIONS]</

cell>
</row>

… repeat for each mapping
</rows>

</table>
</xref>

b Save the above XML files in a directory on the machine where SOA Suite is installed.

c Import the XML into the cross-reference tables, by opening a command prompt or shell.

d Change directory to <SOA_HOME>\integration\esb\bin.

e Set the following environment variables:

❏ OC4J_USERNAME

❏ OC4J_PASSWORD

❏ CRMINTG_DB_URL=<DB Url for x-ref database>

❏ CRMINTG_DB_USER=<DB username for x-ref schema>

❏ CRMINTG_DB_PASSWORD=<DB password for x-ref schema>

❏ GUID_GENERATOR=oracle.crmintg.common.xpath.CRMIntgGUIDGenerator

f Run the following command to import the USERS XML created in the previous step into cross-
reference.

For Windows:
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xrefimport -file <import xml file name with full path> -generate COMMON

For Linux:

./xrefimport.sh -file <import xml file name with full path> -generate COMMON

7 Create Oracle Operating Unit to Responsibility mapping XML and load as a DVM.

a Open the DVM (O_Responsibility.xml) XML file for setting default usernames and business units 
and customize it to your environment.

The file is available from the integration files at:

$CRMINTEG_HOME/SharedComponents/Utility/DVM/Maps/O_Responsibility.xml

This DVM specifies which responsibility to use for a particular Oracle User and Operating Unit 
combination. For example, if the user is OPERATIONS, and the operating unit Id is 204, then 
a responsibility that has 204 as the default operating unit is Order Management Super User, 
Vision Operations (USA). In the map, enter OPERATIONS:204 under the OracleUser-OU cell, 
and 21623:Order Management Super User, Vision Operations (USA) under the 
Oracle_Responsibility cell. 21623 is the responsibility ID.

In this example, the XML file would look the following:

<?xml version="1.0" encoding="UTF-8" ?> 
<dvm name="O_Responsibility" isNew="true">

<description>Given Oracle User and an Org, get the Responsibility</
description>

<columns>
<column name="OracleUser-OU" />
<column name="Oracle_Responsibility" />

</columns>
<rows>

<row>
<cell>OPERATIONS:204</cell>
<cell>21623:Order Management Super User, Vision Operations (USA)</cell>

</row>
<row>

<cell>OPERATIONS:888</cell>
<cell>52489:Order Management Super User, Vision France</cell>

</row>
<row>

<cell>OPERATIONS:911</cell>
<cell>52623:Order Management Super User, Vision Germany</cell>

</row>
</rows>

</dvm>

b Log on to ESB Control.

c Click on the map icon in the top right hand corner.

d The left panel name should now be "Domain Value Maps".

e Click Create and choose "Import a new map".

f Import the DVM file created above.
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8 Set up Default Organization and User for integration using O2C DEFAULT VALUE DVM xml.

a Open the DVM (O2C DEFAULT VALUE) XML file for setting default usernames and business units 
and customize it to your environment.

The file is available from the integration files at:

$CRMINTEG_HOME/SharedComponents/Utility/DVM/Maps/O2C DEFAULT VALUE.xml

This DVM specifies the default user and organization to be used on Siebel CRM and Oracle 
EBS in the process flows. This file contains:

<?xml version="1.0" encoding="UTF-8" ?>
<dvm name="O2C DEFAULT VALUE" isNew="null">

<description>ValueXref O2C DEFAULT VALUE</description>
<columns>

<column name="SIEBEL" />
<column name="ORACLEEBS" />
<column name="COMMON" />

</columns>
<rows>

<row>
<cell>42-4ZC5T</cell>
<cell>204</cell>
<cell>DEFAULT_ORG</cell>

</row>
<row>

<cell>SADMIN</cell>
<cell>OPERATIONS</cell>
<cell>DEFAULT_USER</cell>

</row>
</rows>

</dvm>

b Log on to ESB Control.

c Click on the map icon in the top right hand corner.

d The left panel name should now be Domain Value Maps.

e Click Create and choose Import a new map.

f Import the DVM file created above.

9 Log in to a Siebel application.

10 Navigate to Site Map > Administrations - Group > Positions.

11 Query for the position of Siebel Administrator.

12 Change the division from Default Organization to Vision Operations.
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Validating and Loading Data Value Maps
The Siebel CRM Integration Pack for Oracle Order Management uses DVMs to store mappings 
between Oracle EBS and Siebel CRM lookup values. These are provided with sample data, and should 
each be verified for the specific integration scenario.

To upload DVMs

1 Log on to ESB Control.

2 Click on the map icon in the top right hand corner.

3 The left panel name should now be Domain Value Maps.

4 Click Create and choose Import a new map.

5 Import the following DVMs.

Customer
■ STATE

■ COUNTRY

■ GENDER

■ DEFAULT ORG: After importing this DVM map, please change the SIEBEL column value for 
according to the setup in Siebel. The value in this DVM map is just a sample.

■ PERSONAL TITLE

■ ACCOUNT STATUS

■ CONTACT STATUS

■ ADDRESS STATUS

■ PHONE TYPE CODE

■ WEB TYPE CODE

■ ADDRESS TYPE CODE

■ CUSTOMER TYPE

■ HOME OWNER FLAG

■ MARITAL STATUS

Product
■ PRODUCT STATUS

■ UNIT OF MEASURE
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide

61



Installation and Configuration ■ Configuring Oracle E-Business Suite Application Server
Assets
■ ASSET STATUS

■ CURRENCY CODE

Order/Quotes
■ ORDER TYPE: Source for the ORACLE EBS value is transaction_type_id corresponding to the 

Order Type used for creating orders in Oracle Order Management.

■ ORDER STATUS: Source for the ORACLE EBS value is Workflow Status Code from Order 
Management Lookups.

■ CARRIER TYPE CODE: Source for the ORACLE EBS value is Ship Method Code from Application 
Utilities Lookups.

■ FREIGHT TERMS CODE: Source for the ORACLE EBS value is Freight Terms Code from Order 
Management Lookups.

■ PAYMENT TERM: The source for the ORACLE EBS value is Payment Term Name setup in Order 
Payments.

■ SHIPPING METHOD: The source for the ORACLE EBS value is Shipping Method Code from Order 
Management Lookups.

■ CURRENCY CODE: The source for the ORACLE EBS value is Currency Code from FND 
CURRENCIES.

■ STATE

■ COUNTRY

■ UNIT OF MEASURE

■ RETURN REASON: The source for the ORACLE EBS value is Return Reason is from Credit Memo 
Reason of Receivables lookups.

Credit Check
■ CURRENCY CODE

■ STATE

■ COUNTRY

■ ErrorMessages

■ O_Responsibility

ATP Check
■ UNIT OF MEASURE

■ O_Responsibility
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Payment Authorization
■ CURRENCY CODE

■ STATE

■ COUNTRY

■ PAYMENT TYPE

■ O_Responsibility

Shipping Charges
■ CARRIER TYPE CODE

■ SHIPPING METHOD

■ STATE

■ COUNTRY

■ UNIT OF MEASURE

Configurator
■ LANGUAGE CODE

Deploying Business Processes Execution 
Language Processes
The list of BPEL processes to be deployed is provided below. The processes are ordered in the 
recommended sequence of deployment. There are two methods to deploy the BPEL processes. 
Choose either:

1 Deployment using an Ant script.

2 Deployment using Jdeveloper.

To deploy using an Ant script

1 As Asset processes require database access for compilation, make sure that the Oracle EBS 
database is up.

2 For deployment on Windows, follow these steps:

a Navigate to Start > Programs > SOA > Oracle Process Manager > Developer Prompt.

b Navigate to %CRMINTEG_HOME%\BusinessProcesses.

c Type ant and click enter.

The BPEL Processes listed in the %CRMINTEG_HOME%\BusinessProcesses\build.xml are 
deployed to the domain named default.
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3 For deployment on Linux, follow these steps:

a Run the <SOA Home>/bpel/bin/devprompt.sh.

b Change directory to: In $CRMINTEG_HOME\BusinessProcesses.

c Type ant and click Enter.

The BPEL Processes listed in the %CRMINTEG_HOME%\BusinessProcesses\build.xml are 
deployed to the domain named default.

To deploy using Jdeveloper

1 Open Oracle JDeveloper.

NOTE: These processes must be deployed in the specific order listed.

2 For each process listed below, right-click a process and choose Deploy > [server name] > Deploy 
to default domain.

Common Services
1 CRMIntegGetEBSUserResp

2 CRMIntegErrorHandlerService

Customer
1 CRMIntegXformAcctCOMToEBS11i10

2 CRMIntegXformAcctEBS11i10ToCOM

3 CRMIntegXformAcctEBSToCOMKeyCrossRef

4 CRMIntegMapAccountCOMToSEBL782Sync

5 CRMIntegMapAccountSEBL782ToKeyCrossRefSync

6 CRMIntegMapAccountCOMToKeyCrossRefSync

7 CRMIntegMapAccountSEBL782ToCOMSync

8 CRMIntegMapAccountCOMToCOMSync

9 CRMIntegXformEBSToSEBLAndSyncAcct

10 CRMIntegUpdAcctCOMToEBS11i10Sync

11 CRMIntegSaveOrderAcctCOMToEBS11i10Sync

12 CRMIntegMergeAcctEBS11i10ToSEBL782Sync

13 CRMIntegMergePartyUpdateEBSKey

14 CRMIntegMergePartyEBS11i10ToSEBL782Sync

15 CRMIntegSaveAcctEBS11i10ToSEBL782Sync

16 CRMIntegUpdateAccountSEBL782ToEBS11i10Sync
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17 CRMIntegCreateAccountSEBL782ToEBS11i10Sync

Products
1 Simple Products

a CRMIntegMapSimpleProductCOMToSEBL782

b CRMIntegSimpleProductEBS11i10ToSEBL782Sync

c CRMIntegXformProductOPOraToComEBS11i10ToSEBL782

d CRMIntegSyncProductOPEBS11i10ToSEBL782Async

e CRMIntegSubscribeToCreateProductOPEBS11i10ToSEBL782

f CRMIntegSubscribeToUpdateProductOPEBS11i10ToSEBL782

g CRMIntegSubscribeToBulkloadProductOPEBS11i10ToSEBL782

2 Complex Products

a CRMIntegMapComplexProductSEBL782ToCOM

b CRMIntegMapComplexProductCOMToSEBL782

c CRMIntegSyncItemsForStructuresEBS11i10ToSEBL782Sync

d CRMIntegFetchStructureDataAndXFormToCommonSync

e CRMIntegComplexProductSyncOracle11i10ToSEBL782Sync

f CRMIntegComplexProductEBS11i10ToSEBL782Sync

Assets
1 CRMIntegSyncAssetMapEBS11i10ToCOMSync

2 CRMIntegSyncAssetMapCOMToSEBL782Sync

3 CRMIntegSyncAssetMapCOMToSEBL782UpdateSync

4 CRMIntegSyncAssetMapSEBL782ToCOMSync

5 CRMIntegSyncAssetEBS11i10ToSEBL782Update

6 CRMIntegSyncAssetEBS11i10ToSEBL782Create

Quote
1 CRMIntegMapQuoteCreateSEBL782ToCOMSync

2 CRMIntegMapQuoteCreateCOMToSEBL782Sync

3 CRMIntegMapQuoteCOMToEBS11i10Synch   

4 CRMIntegCreateQuoteSEBL782ToEBS11i10Sync

5 CRMIntegMapQuoteOrgAccountSEBL782ToCOMSync
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6 CRMIntegCreateOrgAccountSEBL782ToEBS11i10Sync

7 CRMIntegSEBLHORQuoteCreate

Configurator
1 CZIntegCopyConfigSEBL782ToEBS11i10Sync

2 CZIntegGetLanguageSync

APIs (Credit Check/ATP/Payment Authorization, and so on)
1 Shipping Charges

a CRMIntegMapShippingChargesSEBL782ToCOMSync

b CRMIntegMapShippingChargesCOMToGLOGSync

c CRMIntegMapShippingChargesCOMToSEBL782Sync

d CRMIntegShippingChargesSEBL782ToEBS11i10Sync

2 ATP Check

a CRMIntegMapATPSEBL782ToCOMSync

b CRMIntegMapATPCOMToEBS11i10Sync

c CRMIntegMapATPEBS11i10ToCOMSync

d CRMIntegMapATPCOMToSEBL782Sync

e CRMIntegCheckATPSEBL782ToEBS11i10Sync

3 Payment Authorization

a CRMIntegMapPaymentSEBL782ToCOMSync

b CRMIntegMapPaymentCOMToEBS11i10Sync

c CRMIntegMapPaymentEBS11i10ToCOMSync

d CRMIntegMapPaymentCOMToSEBL782Sync

e CRMIntegPaymentAuthorizationSEBL782ToEBS11i10Sync

4 Credit Check

a CRMIntegMapCreditSEBL782ToCOMSync

b CRMIntegMapCreditCOMToEBS11i10Sync

c CRMIntegMapCreditEBS11i10ToCOMSync

d CRMIntegMapCreditCOMToSEBL782Sync

e CRMIntegCheckCreditSEBL782ToEBS11i10Sync
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Order
1 CRMIntegMapOrderOrgAccountSEBL782ToCOMSync

2 CRMIntegCreateOrgAccountSEBL782ToEBS11i10Sync

3 CRMIntegMapOrderSEBL782ToCOMSync

4 CRMIntegMapOrderCOMToSEBL782Sync

5 CRMIntegMapOrderCOMToEBS11i10Synch

6 CRMIntegCreateOrderSEBL782ToEBS11i10Sync

7 CRMIntegMapRMAOrderSEBL782ToCOMSync

8 CRMIntegMapRMAOrderCOMToSEBL782Sync

9 CRMIntegCreateRMAOrderSEBL782ToEBS11i10Sync

10 CRMIntegMapUpdateOrderEBS11i10ToCOMSync

11 CRMIntegMapUpdateOrderCOMToSEBL782Sync

12 CRMIntegUpdateOrderCOMToSEBL782Sync

13 CRMIntegUpdateOrderEBS11i10ToSEBL782Sync

14 CRMIntegSEBLHOROrderCreate

Update Order
1 CRMIntegMapUpdateOrderEBS11i10ToCOMSync

2 CRMIntegUpdateOrderEBS11i10ToSEBL782Sync

3 CRMIntegSubscribeToUpdateOrderEBS11i10ToSEBL782Sync

4 CRMIntegMapOrderCOMToEBS11i10Synch

5 CRMIntegMapUpdateOrderSEBL782ToCOMSync

6 CRMIntegMapUpdateOrderCOMToSEBL782Sync
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4 Data Loading
This chapter contains the following information:

■ Prerequisites on page 69

■ Overview of Data Loading on page 69

■ Loading Customer Data on page 70

■ Loading Products Data on page 79

■ Loading Price List Data on page 83

■ Loading Asset Data on page 89

Prerequisites
Make sure the following conditions are met before proceeding with installation and configuration:

■ The OWB Repository is installed and configured according to its standard directions.

■ The OWB Client is installed and configured on each client computer according to its standard 
directions.

■ BPEL Cross-Reference configuration should be complete.

Overview of Data Loading
Siebel CRM Integration Pack for Oracle Order Management requires that the business data in the 
Oracle and Siebel databases is always synchronized. Siebel CRM Integration Pack for Oracle Order 
Management lets you:

■ Initially load your business data in bulk.

■ Synchronize the data that exists in both Oracle and Siebel databases after the initial load is 
complete. For more information, read Chapter 5, “Integrations”.

Bulk loading of business data is a one-way process. Business data is extracted from Oracle 
E-Business Suite, transformed into Siebel database compatible structure and format, and imported 
into Siebel CRM. You can also bulk load at any later date to move over large amounts of business 
data, for example, after a business data purchase or an acquisition made by your organization.
Siebel CRM Integration Pack for Oracle Order Management Implementation
Guide

69



Data Loading ■ Loading Customer Data
Figure 2 illustrates the data bulk load process at a high level.

NOTE: You should initially bulk load these business data types in this order:

1 Customer. For more information on customer bulk load, read “Loading Customer Data” on 
page 70.

2 Product. For more information on product bulk load, read “Loading Products Data” on page 79.

3 Price List (dependent on Products). For more information on price list bulk load, read 
“Loading Price List Data” on page 83.

4 Asset (dependent on Products). For more information on asset bulk load, read “Loading Asset 
Data” on page 89.

Loading Customer Data
Siebel CRM Integration Pack for Oracle Order Management provides you with a bulk load feature to 
move data from Oracle E-Business Suite into Siebel CRM.

Overview of Customer Data Bulk Load
The bulk load feature extracts customer data from Oracle E-Business Suite, transforms it into EIM 
interface table data structures, and moves it into the Siebel EIM interface tables. Siebel EIM tables 
are intermediate interface tables that act as a staging area between the base tables in Siebel 
database and other databases. A Siebel loader program moves the data from the EIM interface tables 
into the application base tables of Siebel CRM.

Figure 3 illustrates the customer data bulk load process.

Figure 2. Initial Data Bulk Load Process
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During the initial bulk load, only active Organization parties and their child objects, including 
organization contacts that are associated with an account in Oracle, are extracted from Oracle and 
loaded into Siebel CRM. Organization contacts are person parties with a relationship to the 
organization party.

While Oracle Organization parties are loaded into Siebel CRM as accounts, Oracle Organization 
contacts are loaded into Siebel CRM as Account contacts (along with a contact record in Siebel CRM 
for contact person party in Oracle E-business Suite).

NOTE: Person parties and their child objects are not loaded because Siebel CRM Integration Pack for 
Oracle Order Management does not support the business to customer (B2C) ordering flow.

Prerequisites for Loading Customer Data
Bulk loading of customer data has the following prerequisites:

Figure 3. Initial Customer Data Bulk Load from Oracle E-Business Suite to Siebel CRM.
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■ Oracle E-Business Suite 11.5.10.CU2 is installed on Oracle 9i (9.2.07) or newer database and 
you have access to the following database objects:

■ HZ_CONTACT_POINTS

■ HZ_CUST_ACCOUNTS

■ HZ_CUST_ACCOUNT_ROLES

■ HZ_CUST_ACCT_SITES_ALL

■ HZ_CUST_SITE_USES_ALL

■ HZ_GEOGRAPHIES

■ HZ_GEOGRAPHY_IDENTIFIERS

■ HZ_LOCATIONS

■ HZ_ORG_CONTACTS

■ HZ_PARTIES

■ HZ_PARTY_SITES

■ HZ_PERSON_PROFILES

■ HZ_RELATIONSHIPS

■ HR_OPERATING_UNITS

■ Oracle Warehouse Builder (OWB) 10.2 is installed on Oracle 9i (9.2.07) or newer database for 
OWB Deployment Target and repository creation.

■ You have SYS access to the database for OWB repository creation.

■ There is a directory in the file system on the same machine as the database to keep Domain 
Value Mapping (DVM) Cross reference files.

■ Siebel 7.8.2.3 is installed on Oracle 9i (9.2.07) or higher database and you have access to the 
following database objects:

■ EIM_ACCOUNT

■ EIM_CONTACT

■ S_ADDR_ORG

■ S_CONTACT

■ S_ORG_EXT

■ You have a cross reference ID population database on which you have read and write access to 
XREF_DATA.

Loading Customer and Contact Data
The customer data bulk load process involves:

1 To generate CSV files for the Domain Value Maps XML files for customer data on page 73
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2 To move customer data into EIM tables using the Oracle Warehouse Builder on page 74

3 To import the customer data from EIM tables to Siebel base tables on page 75

4 To populate Oracle-Siebel unique ID cross-reference information for customer data on page 78

To generate CSV files for the Domain Value Maps XML files for customer data

1 Make sure that following DVMs are up-to-date as per your requirements.

For more information, refer to“Validating and Loading Data Value Maps” on page 61.

■ COUNTRY

■ GENDER

■ PERSONAL TITLE

2 Export the DVMs into an XML format using the Export feature on the Domain Value Maps page.

3 Save them into a directory on the SOA server, such as /user/DVMMaps.

4 In JDeveloper, open the following file:

%CRMINTEG_HOME%\BusinessProcesses\CommonServices\CRMIntgSoaDvmToOwbCsv.jpr

This opens the CRMIntgSoaDvmToOwbCsv BPEL process.

5 In the BPEL process, open bpel.xml file (shown below), change the highlighted text to an 
appropriate directory on your SOA server (such as /user/DVMMaps) and save the file.

<?xml version = '1.0' encoding = 'UTF-8'?>
<BPELSuitcase>

<BPELProcess id="CRMIntgSoaDvmToOwbCsv" src="CRMIntgSoaDvmToOwbCsv.bpel">
<partnerLinkBindings>

<partnerLinkBinding name="DVMFileLocation">
<property name="wsdlLocation">DVMFileLocation.wsdl</property>

</partnerLinkBinding>
<partnerLinkBinding name="WriteToCsv">

<property name="wsdlLocation">WriteToCsv.wsdl</property>
<property name="DVMXmlToCsvConvertLocation"

type="LogicalDirectory">\DVMToCSVHotspot</property>
<property name="retryInterval">60</property>

</partnerLinkBinding>
</partnerLinkBindings>
<activationAgents>

<activationAgent 
className="oracle.tip.adapter.fw.agent.jca.JCAActivationAgent" 
partnerLink="DVMFileLocation">

<property name="DVMXmlToCsvConvertLocation" 
type="LogicalDirectory">\DVMToCSVHotspot</property>

<property name="portType">Read_ptt</property>
</activationAgent>

</activationAgents>
</BPELProcess>

</BPELSuitcase>
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6 Deploy the BPEL process.

7 Refresh the contents of the directory (mentioned in above case /user/DVMMaps) until you find 
the corresponding CSV files:

■ COUNTRY.csv

■ GENDER.csv

■ PERSONAL TITLE.csv

8 Copy these files into a directory of your choice on the machine where you plan to run the Oracle 
Warehouse Builder (OWB) Design Center.

For more information on BPEL process deployments, read Chapter 3, “Installation and 
Configuration.”

To move customer data into EIM tables using the Oracle Warehouse Builder

1 Make sure that Oracle Warehouse Builder (OWB) is installed and operational.

For more information on installing and configuring the OWB Repository Runtime and Client, read 
Chapter 3, “Installation and Configuration.”

2 Start the OWB Design Center to connect to OWB Repository.

3 Navigate to Design > Import > Warehouse Builder Metadata.

4 Import the CRMINTG_XFER_CUST_TO_CRM.mdl file supplied by Oracle from the OWB Repository.

This creates a project named CRMINTG_XFER_CUST_TO_CRM. As part of this project, there are 
four Oracle database schemas involved. You can find them under Databases > Oracle.

■ CRMINTG_ID_XREF_MODULE (Read/Write access) - this represents Oracle user/schema for 
ID Cross Reference data

■ CRMINTG_ORCL_CDH_MODULE (Read access) - this represents Oracle user/schema for 
Oracle Customer Data Hub/TCA

■ CRMINTG_OWB_REPOS_MODULE (Read/Write access) - this represents Oracle user/schema 
that is used by OWB during runtime

■ CRMINTG_SEBL_CRM_MODULE (Read/Write access) – this represents Oracle user/schema 
for Siebel EIM tables.

This design assumes that CRMINTG_OWB_REPOS_MODULE schema does not exist in same 
database as any other schema. In otherwise case, the user for CRMINTG_OWB_REPOS_MODULE 
needs to be granted appropriate read and write access for the other schemas that are in the same 
database. If access to the whole schema is not desirable, then you could expand the appropriate 
“%%%_MODULE” and look for tables or sequences that are used by OWB and only grant access 
to those. For example, if CRMINTG_ID_XREF_MODULE is in the same database as 
CRMINTG_OWB_REPOS_MODULE, then grant access to XREF_DATA, CRMINTG_CID_SEQUENCE 
and CRMINTG_UID_SEQUENCE to the user for CRMINTG_OWB_REPOS_MODULE.

The MDL provides an Expert, a wizard-based tool that guides you through the initial configuration 
steps. It also provides the initial design for bulk load.

5 Run the Expert to configure and deploy Oracle-Siebel mapping.
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6 Select Experts > CRMINTG_CUST_XFER_XPRT > DO_DEPLOY_AFTER_IMPORT.

Provide the connection information to both Oracle EBS and Siebel CRM databases, the directory 
where DVM CSV files are located, and the location of the cross reference ID population database. 
The Expert configures the initial design, generates and compiles all the Oracle-Siebel mapping 
executable components, and deploys them into the specified OWB repository.

7 Navigate to Tools > Control Center Manager.

8 Navigate to CRMINTG_XFER_CUST_TO_CRM > CRMINTG_OWB_REPOS_LOC > 
CRMINTG_OWB_REPOS_MODULE > Mappings.

9 Execute CRMINTG_PRELOAD_COUNTRY_DVM, CRMINTG_PRELOAD_GENDER_DVM and 
CRMINTG_PRELOAD_PER_TITLE_DVM in that order to load all Oracle to Siebel Data Value 
Mapping information.

10 Execute the following maps in this order:

■ CRMINTG_ORG_ACCT_1_MTCH_MRGE

■ CRMINTG_ORG_ACCT_2_TO_LOCL_EIM

■ CRMINTG_ORG_ACCT_3_TO_SEBL_EIM

This loads data into Siebel's EIM interface table EIM_ACCOUNT.

11 Navigate to a Siebel application and run appropriate program to load data from the 
EIM_ACCOUNT table into the Siebel main tables. For more information, read “To import the 
customer data from EIM tables to Siebel base tables” on page 75.

12 Execute the CRMINTG_ORG_ACCT_4_CREATE_XREF map to populate ID cross-reference 
information.

This information is used during on-going synchronization of customer information.

13 Execute the following maps in this order:

■ CRMINTG_ORG_CONT_1_TO_LOCL_EIM

■ CRMINTG_ORG_CONT_2_TO_SEBL_EIM

This loads data into Siebel's EIM interface table EIM_CONTACT.

14 Navigate to a Siebel application and run appropriate program to load data from the 
EIM_CONTACT table into the Siebel main tables. For more information, read “To import the 
customer data from EIM tables to Siebel base tables” on page 75.

15 Execute the CRMINTG_ORG_CONT_3_CREATE_XREF map to populate ID cross-reference 
information.

This information is used during on-going synchronization of customer information.

To import the customer data from EIM tables to Siebel base tables

1 Log in to a Siebel application.
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2 Define the process for EIM tables to perform, for example import, by editing the configuration 
file that the process is based on.

The default configuration file is default.ifb, an ASCII text file with the extension .IFB that resides 
in the server\admin directory.

a Define the process for customer data load.

Create a new EIM configuration file, account.ifb, with the following details:

TYPE = IMPORT
TABLE = EIM_ACCOUNT
ONLY BASE TABLES = S_PARTY, S_ORG_EXT, S_ADDR_ORG, S_ORG_BU, S_ACCNT_POSTN

DEFAULT COLUMN = ROOT_PARTY_FLG, "N"
DEFAULT COLUMN = ROW_STATUS, "Y"
DEFAULT COLUMN = ACTIVE_FLG, "Y"
DEFAULT COLUMN = CONTRACT_VIS_FLG, "N"
DEFAULT COLUMN = DISA_CLEANSE_FLG, "N"
DEFAULT COLUMN = EVT_LOC_FLG, "N"
DEFAULT COLUMN = FCST_ORG_FLG, "N"

DEFAULT COLUMN = FUND_ELIG_FLG, "N"
DEFAULT COLUMN = INT_ORG_FLG, "N"
DEFAULT COLUMN = PROSPECT_FLG, "N"
DEFAULT COLUMN = PRTNR_FLG, "N"
DEFAULT COLUMN = PRTNR_PUBLISH_FLG, "N"
DEFAULT COLUMN = RPLCD_WTH_CMPT_FLG, "N"
DEFAULT COLUMN = SKIP_PO_CRDCHK_FLG, "N"
DEFAULT COLUMN = ADDR_NAME_LOCK_FLG, "N"
DEFAULT COLUMN = ADDR_DISACLEANSEFL, "N"

DEFAULT COLUMN = ADDR_ACTIVE_FLG, "Y"
DEFAULT COLUMN = ADDR_MAIN_ADDR_FLG, "N"

DEFAULT COLUMN = ADDR_SHIP_ADDR_FLG, "N"
DEFAULT COLUMN = ADDR_BL_ADDR_FLG, "N"

DEFAULT COLUMN = POSTN_DIVN, "Default Organization"
DEFAULT COLUMN = POSTN_BU, "Default Organization"
DEFAULT COLUMN = POSTN_LOC, "INTERNAL"
DEFAULT COLUMN = POSTN_NAME, "Siebel Administrator"
DEFAULT COLUMN = ACCNT_BU, "Default Organization"
DEFAULT COLUMN = VIS_BU, "Default Organization"

NOTE: If EIM has to be run for the same set of data, then first run EIM delete with the following 
configuration details.

delete.ifb

[Siebel Interface Manager]
LOG TRANSACTIONS = TRUE

[DELETE_ACCOUNT]
TYPE = DELETE
BATCH = 100
TABLE = EIM_ACCOUNT
DELETE MATCHES = S_ORG_EXT,(INTEGRATION_ID IS NOT null)
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b Define the process for contact data load.

Create a new EIM configuration file, contact.ifb, with the following details:

[IMPORT_CONTACT]
TYPE = IMPORT
TABLE = EIM_CONTACT
BATCH = 100
ONLY BASE TABLES = S_PARTY, S_CONTACT, S_POSTN_CON, S_CONTACT_BU, S_PARTY_PER

DEFAULT COLUMN = ROOT_PARTY_FLG, "N"
DEFAULT COLUMN = CON_ACTIVE_FLG, "Y"
DEFAULT COLUMN = CON_DISACLEANSEFLG, "N"
DEFAULT COLUMN = CON_DISPIMGAUTHFLG, "N"
DEFAULT COLUMN = CON_EMAILSRUPD_FLG, "N"
DEFAULT COLUMN = CON_EMP_FLG, "N"
DEFAULT COLUMN = CON_PO_PAY_FLG, "N"
DEFAULT COLUMN = CON_PROSPECT_FLG, "N"

DEFAULT COLUMN = CON_PTSHPCONTACTFL, "N"
DEFAULT COLUMN = CON_PTSHPKEYCONFLG, "N"
DEFAULT COLUMN = CON_SUPPRESSEMAILF, "N"
DEFAULT COLUMN = CON_SUPPRESSFAXFLG, "N"
DEFAULT COLUMN = CON_SENDSURVEY_FLG, "N"
DEFAULT COLUMN = PC_ROW_STATUS, "Y"
DEFAULT COLUMN = ADDR_NAME_LOCK_FLG, "N"
DEFAULT COLUMN = ADDR_DISACLEANSEFL, "N"
DEFAULT COLUMN = PC_POSTN_DIVN, "Default Organization"
DEFAULT COLUMN = PC_POSTN_BU, "Default Organization"

DEFAULT COLUMN = PC_POSTN_LOC, "INTERNAL"
DEFAULT COLUMN = PC_POSTN_NAME, "Siebel Administrator"
DEFAULT COLUMN = CON_PR_POSTN, "Y"
DEFAULT COLUMN = PC_STATUS, "Active"
DEFAULT COLUMN = PP_START_DT, "16-AUG-06"
DEFAULT COLUMN = CON_BU, "Default Organization"
DEFAULT COLUMN = CB_BU, "Default Organization"
DEFAULT COLUMN = DEPT_ACCNT_BU, "Default Organization"

NOTE: If EIM has to be run for the same set of data, then first run EIM delete with the following 
configuration details.

delete.ifb
[Siebel Interface Manager]
LOG TRANSACTIONS = TRUE

[DELETE_CONTACT]
TYPE = DELETE
BATCH = 100
TABLE = EIM_CONTACT
DELETE MATCHES = S_CONTACT,(INTEGRATION_ID IS NOT null)

3 Run the EIM process.

a For customer data load, run EIM_ACCOUNT with the account.ifb EIM configuration file.
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b For contact data load, run EIM_ACCOUNT with the contact.ifb EIM configuration file.

NOTE: Before running contact bulk load, make sure that customer bulk load is complete.

You can submit the EIM process as a Siebel server batch component task either from the 
Administration–Server Management views or from the Server Manager Command Line interface.

Use the following command to run EIM processes:

start task for comp eim with config= <IFB Filename>, process=<Process Name As In IFB File>

TIP: This command to run EIM processes would translate as follows for customer and contact 
data loads:

4 Verify results.

The EIM component task produces a trace log (EIN_task#.log). When the EIM process is run, the 
records should have the status IMPORTED. Review records with status PARTIALLY_IMPORTED for 
potential data issues.

NOTE: Status PARTIALLY_IMPORTED is normal for records without any address information 
populated. Because data is loaded into address tables also, the status is PARTIALLY_IMPORTED 
for records without addresses.

For more information on configuring the Siebel CRM environment, read Chapter 3, “Installation 
and Configuration.”

To populate Oracle-Siebel unique ID cross-reference information for customer data
Use OWB to extract data from Siebel base tables and also to populate the key cross reference tables.

Execute the CRMINTG_ORG_CONT_3_CREATE_XREF map to populate ID cross reference 
information.

NOTE: The ID cross reference information is later used during ongoing synchronization of customer 
information.

Table 1. Commands to Run EIM Processes

EIM process Command

Load customer data start task for comp eim with config=Account.ifb, 
process="IMPORT_ACCOUNT"

Delete customer data start task for comp eim with config=Delete.ifb, 
process="DELETE_ACCOUNT"

Load contact data start task for comp eim with config=Contact.ifb, 
process="IMPORT_CONTACT"

Delete contact data start task for comp eim with config=Delete.ifb, 
process="DELETE_CONTACT"
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Loading Products Data
Use the bulk load feature to move product data from Oracle E-Business Suite into Siebel CRM.

Overview of Products Data Bulk Load
Bulk loading product data is similar to bulk loading customer data. The bulk load feature extracts 
product data from Oracle E-Business Suite, transforms it into EIM interface table data structures, 
and moves it into the Siebel EIM interface tables. A Siebel loader program moves the data from the 
EIM interface tables into the application base tables of Siebel CRM.

Prerequisites for Loading Product Data
Bulk loading of product data has all the prerequisites for loading customer data. For more information 
read, Prerequisites for Loading Customer Data on page 71.

In addition, the process has the following extra prerequisites:

■ Create the identified business unit and the related inventory locations in Siebel CRM.

■ Synchronize the business unit ID and the inventory locations into the cross reference ID 
population database, using the XREF Tool.

■ Records that have Customer Ordered or Customer Orders Enabled are synchronized with Siebel 
CRM.

■ Oracle E-Business Suite 11.5.10.CU2 is installed on Oracle 9i (9.2.07) or newer database and 
you have access to the following database objects:

■ EIM_PROD_INT

■ EIM_PROD_INT1

■ EIM_PRODINVLOC

■ S_PROD_INT

■ S_PROD_INVLOC

Loading Product Data
The product data bulk load involves:

1 To generate CSV files for the Domain Value Maps XML files for product data on page 80

2 To move product data into EIM tables using the Oracle Warehouse Builder on page 81

3 To import the product data from EIM tables to Siebel base tables on page 81

4 To populate Oracle-Siebel unique ID cross reference information for product data on page 83
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To generate CSV files for the Domain Value Maps XML files for product data

1 Make sure that following DVMs are up-to-date as per your requirements.

For more information, read “Validating and Loading Data Value Maps” on page 61.

■ PRODUCT STATUS

■ UNIT OF MEASURE

2 Export the DVMs into an XML format using the Export feature on the Domain Value Maps page.

3 Save them into a directory on the SOA server, such as /user/DVMMaps.

4 In JDeveloper open the following file:

%CRMINTEG_HOME%\BusinessProcesses\CommonServices\CRMIntgSoaDvmToOwbCsv.jpr

This opens the CRMIntgSoaDvmToOwbCsv BPEL process.

5 In the BPEL process, open bpel.xml file (shown below), change the highlighted text to an 
appropriate directory on your SOA server (such as /user/DVMMaps) and save the file. 

c:\myDVMs\DVMHotspotas.

<?xml version = '1.0' encoding = 'UTF-8'?>
<BPELSuitcase>

<BPELProcess id="CRMIntgSoaDvmToOwbCsv" src="CRMIntgSoaDvmToOwbCsv.bpel">
<partnerLinkBindings>

<partnerLinkBinding name="DVMFileLocation">
<property name="wsdlLocation">DVMFileLocation.wsdl</property>

</partnerLinkBinding>
<partnerLinkBinding name="WriteToCsv">

<property name="wsdlLocation">WriteToCsv.wsdl</property>
<property name="DVMXmlToCsvConvertLocation"

type="LogicalDirectory">\DVMToCSVHotspot</property>
<property name="retryInterval">60</property>

</partnerLinkBinding>
</partnerLinkBindings>
<activationAgents>

<activationAgent 
className="oracle.tip.adapter.fw.agent.jca.JCAActivationAgent" 
partnerLink="DVMFileLocation">

<property name="DVMXmlToCsvConvertLocation" 
type="LogicalDirectory">\DVMToCSVHotspot</property>

<property name="portType">Read_ptt</property>
</activationAgent>

</activationAgents>
</BPELProcess>

</BPELSuitcase>

6 Deploy the BPEL process.

7 Refresh the contents of the directory (mentioned above as /user/DVMMaps) until you find the 
corresponding CSV files:

■ PRODUCT STATUS.csv

■ UNIT OF MEASURE.csv
Siebel CRM Integration Pack for Oracle Order Management Implementation 
Guide  

80 



Data Loading ■ Loading Products Data
8 Copy these files into a directory of your choice on the machine where you plan to run the Oracle 
Warehouse Builder (OWB) Design Center.

To move product data into EIM tables using the Oracle Warehouse Builder

1 Make sure that Oracle Warehouse Builder (OWB) is installed and operational.

For more information on installing and configuring the OWB Repository Runtime and Client, read 
Chapter 3, “Installation and Configuration.”

2 Start the OWB Design Center to connect to OWB Repository.

3 Navigate to Design > Import > Warehouse Builder Metadata.

4 Import the CRMINTEG_PRODUCT_LOAD_OP.mdl file supplied by Oracle from the OWB Repository.

The MDL provides an Expert, a wizard-based tool that guides you through the initial configuration 
steps. It also provides the initial design for bulk load.

5 Choose Experts > CRMINTEG_PRODUCT_EXPERT_MODULE > CRMINTEG_PRODUCT_EXPERT > 
Run

Provide the connection information to both Oracle and Siebel databases, the directory where DVM 
CSV files are located, and the location of the cross reference ID population database. The Expert 
configures the initial design, generates and compiles all the Oracle-Siebel mapping executable 
components, and deploys them into the specified OWB repository.

6 Navigate to Tools > Control Center Manager.

7 Navigate to Tools > Control Centre Manager > CRMINTEG_PRODUCT_LOAD_OP-> 
CRMINTEG_PRODUCT_OWB_LOC_OP > CRMINTEG_PRODUCT_OWB_MODULE_OP > Mappings.

8 Start the execution of mapping in the following sequence.
1. CRMINTEG_PRODUCT_STATUS_LKUP_1 
2. CRMINTEG_PRODUCT_UOM_LKUP_2 
3. CRMINTEG_PRODUCT_EBS_TO_SBL_3 

Running the mapping extracts product data from the Oracle E-Business Suite tables, transforms 
it into structure and format compatible with the appropriate Siebel EIM table (EIM_PRODUCT), 
and loads the EIM table.

To import the product data from EIM tables to Siebel base tables

1 Log in to a Siebel application.

2 Define the process for EIM tables to perform, for example import, by editing the configuration 
file that the process is based on.

The default configuration file is default.ifb, an ASCII text file with the extension .IFB that resides 
in the server\admin directory.

To define the process for product data load, create a new EIM configuration file, prod.ifb, with 
the following details:
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[Siebel Interface Manager]
LOG TRANSACTIONS = TRUE
PROCESS = Import Everything

[IMPORT EIM INT]
BATCH = 200
TYPE = IMPORT
TABLE = EIM_PROD_INT
ONLY BASE TABLES = S_PROD_INT, S_PROD_INT_BU

DEFAULT COLUMN = FEATURED_FLG, "N",
DEFAULT COLUMN = ACTIVE_FLG, "Y",
DEFAULT COLUMN = AUTO_UNGROUP_FLG, "N",
DEFAULT COLUMN = CMPND_FLG, "N",
DEFAULT COLUMN = COMPENSATABLE_FLG, "Y",
DEFAULT COLUMN = CRT_AGREEMENT_FLG, "N"
DEFAULT COLUMN = CRT_AST_REC_FLG, "Y",
DEFAULT COLUMN = CRT_INST_FLG, "Y",
DEFAULT COLUMN = ENTERPRISE_FLG, "N",
DEFAULT COLUMN = INCLSV_ELIG_RL_FLG, "N",
DEFAULT COLUMN = PRD_INCLALLCRSEFLG, "N",
DEFAULT COLUMN = TARGET_VRSN_FLG, "N",
DEFAULT COLUMN = TAX_SUBCOMP_FLG, "N",
DEFAULT COLUMN = SALES_SRVC_FLG, "N",
DEFAULT COLUMN = SALES_PROD_FLG, "Y",
DEFAULT COLUMN = POSTN_BL_PROD_FLG, "N",
DEFAULT COLUMN = PROD_CD, "Product",
DEFAULT COLUMN = PRICE_TYPE_CD, "One-Time"
DEFAULT COLUMN = PROD_PROD_TYPE_CD, "Bundle"
DEFAULT COLUMN = VIS_ACTIVE_FLG, "Y"
DEFAULT COLUMN = VIS_ORDERABLE_FLG, "Y"
DEFAULT COLUMN = VIS_SALES_PROD_FLG, "Y"

[IMPORT EIM INT1]
BATCH = 200
TYPE = IMPORT
TABLE = EIM_PROD_INT1
BASE TABLES = S_PROD_INT

[IMPORT PRODINVLOC]
BATCH = 200
TYPE = IMPORT
TABLE = EIM_PRODINVLOC
ONLY BASE TABLES = S_PROD_INVLOC, S_PROD_INV, S_PROD_INV_CNT

NOTE: PROD_PROD_TYPE_CD is defaulted to Bundle and Customizable respectively for simple 
and complex products.

3 Run the EIM process.

For product data load, run EIM_ACCOUNT with the prod.ifb EIM configuration file.

You can submit the EIM process as a Siebel server batch component task either from the 
Administration–Server Management views or from the Server Manager Command Line interface.

Use the following commands to run EIM processes:
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■ start task for component eim with config=Prod.ifb, TraceFlags=1, ErrorFlags=1, SQLFlags=8, 
process="IMPORT EIM INT"

■ start task for component eim with config=Prod.ifb, TraceFlags=8, ErrorFlags=8, SQLFlags=8, 
process="IMPORT EIM INT1" 

■ start task for component eim with config=Prod.ifb, TraceFlags=1, ErrorFlags=1, SQLFlags=8, 
process="IMPORT PRODINVLOC"

4 Verify results.

The EIM component task produces a trace log (EIN_task#.log). When the EIM process is run, the 
records should have the status IMPORTED. Review records with status PARTIALLY_IMPORTED for 
potential data issues.

For more information on configuring the Siebel CRM environment, read Chapter 3, “Installation 
and Configuration.”

To populate Oracle-Siebel unique ID cross reference information for product data
Use OWB to extract data from Siebel base tables and also to populate the key cross reference tables.

Execute the CRMINTEG_UPDXREF_CRM_TO_XREF map to populate ID cross reference information.

The ID cross reference information is later used during ongoing synchronization of product 
information.

Loading Price List Data
Use the bulk load feature to move active price list data related to order capture, from Oracle 
E-Business Suite into Siebel CRM:

■ Active header information, such as name, currency, start date, and end date.

■ Line information, such as product, list price, start date, and end date.

Overview of Price List Data Bulk Load
Bulk loading of price list data is similar to loading other data types in that the bulk load feature 
extracts price list data from Oracle E-Business Suite, transforms it into EIM interface table data 
structures, and moves it into the Siebel EIM interface tables. A Siebel loader program moves the data 
from the EIM interface tables into the application base tables of Siebel CRM.

Bulk loading of price list data is different in that you can also synchronize changes to active price list 
data in Oracle E-business Suite database to Siebel CRM database. These changes after the initial bulk 
load could be either creation of new price lists or updates to the header and line information of 
existing price lists. The incremental bulk loads create or update price lists or the header and line 
information in Siebel CRM database, depending on whether or not the price lists or the header and 
line information already exist in Siebel CRM database.
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Prerequisites for Loading Price List Data
Bulk loading of price list data has all the prerequisites for loading customer data. For more 
information read, Prerequisites for Loading Customer Data on page 71.

In addition, the process has the following extra prerequisites:

■ Make sure that product bulk load is complete and products are loaded into Siebel CRM database.

■ Synchronize the business unit ID and the inventory locations.

■ Create the Price List Oracle E-Business Suite view.

The Price List Oracle E-Business Suite view represents the price list information in Oracle 
E-Business Suite database, and the view data is used to do the initial bulk load of price list data 
type into Siebel CRM.

Create the PriceList Oracle E-Business Suite view by logging into the Oracle E-Business Suite 
database and running this script:

CREATE OR REPLACE VIEW CRMINTEG_PRICELIST_V ( LIST_HEADER_ID,
NAME, CURRENCY_CODE, HEADER_START_DATE, HEADER_END_DATE,
ORIG_ORG_ID, OU_NAME, SHIP_METHOD_CODE, FREIGHT_TERMS_CODE,
DESCRIPTION, LIST_LINE_ID, LINE_START_DATE, LINE_END_DATE,
PRODUCT_ATTR_VALUE, PRODUCT_UOM_CODE, OPERAND, INVENTORY_ITEM_ID,
CONCATENATED_SEGMENTS, ORGANIZATION_ID, ORGANIZATION_CODE, ACTIVE_FLAG, 
ITEM_ORG_NAME)
AS SELECT
a.list_header_id,
a.name,
a.currency_code,
a.start_date_active HEADER_START_DATE,
a.end_date_active HEADER_END_DATE,
a.orig_org_id,
(select name from hr_operating_units b where b.organization_id = a.orig_org_id) 
ou_name,
a.ship_method_code,
a.freight_terms_code,
a.description,
c.list_line_id,
c.start_date_active LINE_START_DATE,
c.end_date_active LINE_END_DATE,
f.product_attr_value,
f.product_uom_code,
c.operand,
d.inventory_item_id,
d.concatenated_segments,
e.organization_id,
e.ORGANIZATION_CODE,
a.ACTIVE_FLAG,
HAOU.name item_org_name
from
qp_list_headers_vl a,
qp_list_lines c,
mtl_system_items_b_kfv d,
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mtl_parameters e,
qp_pricing_attributes f,
HR_ALL_ORGANIZATION_UNITS HAOU,
HR_ORGANIZATION_INFORMATION HOI
where
a.list_header_id = c.list_header_id
and c.list_line_id = f.list_line_id
and a.list_type_code = 'PRL'
and a.pte_code ='ORDFUL'
and c.list_line_type_code ='PLL'
and f.product_attribute_context = 'ITEM' -- item
and f.product_attribute = 'PRICING_ATTRIBUTE1' --item number
and f.pricing_attribute_context is null
and f.pricing_attribute is null
and f.pricing_attr_value_from is null
and c.list_line_id not in
(select to_rltd_modifier_id from qp_rltd_modifiers where from_rltd_modifier_id in
(select list_line_id from qp_list_lines where list_line_type_code = 'PBH'))
and c.price_by_formula_id is null
and d.inventory_item_id = to_number(f.product_attr_value)
--and d.organization_id = fnd_profile.value('QP_ORGANIZATION_ID')
and d.organization_id = e.organization_id
and c.pricing_phase_id = 1
and c.qualification_ind = 4
and f.product_uom_code = d.primary_uom_code
and c.generate_using_formula_id is null
and d.ORGANIZATION_ID = HOI.ORGANIZATION_ID
AND UPPER((HOI.ORG_INFORMATION_CONTEXT||'')) ='ACCOUNTING INFORMATION'
AND HAOU.ORGANIZATION_ID = DECODE(ORG_INFORMATION_CONTEXT, 'Accounting 
Information',
TO_NUMBER(ORG_INFORMATION3), TO_NUMBER(NULL))

■ Create a list of values table in the OWB Repository for storing Oracle EBS and Siebel CRM price 
list Freight Code values. Use this script to create the table and load the values:

Create table PRILSTFREIGHTCD
(ORACLETYPE varchar2(50) primary key,
SIEBELTYPE varchar2(50));

insert into PRILSTFREIGHTCD values('due','Due');
insert into PRILSTFREIGHTCD values('paid','TBD');

■ Create a list of values table in the OWB Repository for storing Oracle EBS and Siebel CRM price 
list Shipping Method Types values. Use this script to create the table and load the values:

Create table PRILSTSHIPMETHCD
(ORACLETYPE varchar2(50) primary key,
SIEBELTYPE varchar2(50));

insert into PRILSTSHIPMETHCD values('TBD','TBD');
insert into PRILSTSHIPMETHCD values('DHL','DHL');
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■ Create a flat file for incremental loads. The file is used to store the names of Price lists for 
incremental load. The file name must be PriceListData.txt. The folder location is specified during 
the expert module execution. The data in the file is stored like given below. The first line must 
not be changed. The names of the price lists to be loaded must be given from second line within 
double quotes.

Name
"EAM M1 Maintenance Price List"
"Business World"
"Pricelist222"
"PriceList223"

■ Create a temporary table in the OWB Repository for storing incremental price lists. The bulk 
loading feature loads the names of incremental price lists into this temporary table before loading 
them into the Siebel EIM tables. Use this script to create the table:

Create Table TmpPriceListName(Name varchar2(240));

■ Create a flat table in the OWB Repository to serve as an intermediate store for Oracle-Siebel 
unique ID cross reference information. The bulk load feature uses this table to temporarily store 
cross reference data before loading it into the cross reference ID database. Every time the cross 
reference map is run, this table is cleaned and fresh data is loaded.

Use this script to create the table:

Create table XREF_DATA_FLAT
(XREF_GUID VARCHAR2(48),
ROW_NUMBER VARCHAR2(48),
XREF_ORCL_COLUMN_GUID VARCHAR2(48),
ORCL_VALUE VARCHAR2(4000),
XREF_SEBL_COLUMN_GUID VARCHAR2(48),
SEBL_VALUE VARCHAR2(4000),
XREF_COMM_COLUMN_GUID VARCHAR2(48),
COMM_VALUE VARCHAR2(4000),
IS_DELETED VARCHAR2(1),
LAST_CRUD_DATE VARCHAR2(100));

NOTE: If you have already created this table for the initial bulk load of other data types, you 
need not recreate it.

Loading Price List Data
The price list bulk load involves:

1 To move price list data into EIM tables using the Oracle Warehouse Builder on page 87

2 To import the price list data from EIM tables to Siebel base tables on page 88
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To move price list data into EIM tables using the Oracle Warehouse Builder

1 Make sure that Oracle Warehouse Builder (OWB) is installed and operational.

For more information on installing and configuring the OWB Repository Runtime and Client, read 
Chapter 3, “Installation and Configuration.”

2 Start the OWB browser listener, Control Center Service, and OWB Design Center to connect to 
OWB Repository.

3 Import the MDL file (CRMINTEG_PRICELIST_LOAD.mdl) and run the Expert module.

The OWB provides an Expert, a wizard-based tool that guides you through the initial 
configuration steps. It also provides the initial design for bulk load. When the Expert completes, 
the maps available in MDL file are deployed.

4 Navigate to Tools > Control Center Manager > CRMINTEG_PRICELIST_LOAD > 
CRMINTEG_PL_OWB_LOC > CRMINTEG_OWBREPOS_MODULE > MAPPINGS > 
CRMINTEG_EBS_TO_SEBL.

5 After running this file, import the results from EIM into the Siebel base tables as described in To 
import the price list data from EIM tables to Siebel base tables on page 88.

6 In OWB, Navigate to Tools > Control Center Manager > CRMINTEG_PRICELIST_LOAD > 
CRMINTEG_PL_OWB_LOC > CRMINTEG_OWBREPOS_MODULE > MAPPINGS > 
CRMINTEG_SEBLHEADER_TO_XREF. 

7 In OWB, Navigate to Tools > Control Center Manager > CRMINTEG_PRICELIST_LOAD > 
CRMINTEG_PL_OWB_LOC > CRMINTEG_OWBREPOS_MODULE > MAPPINGS > 
CRMINTEG_SEBLLINE_TO_XREF. 

NOTE: For incremental bulk load, modify PriceListData.txt with the price list names and run 
these maps instead:

■ CRMINTEG_TXT_TO_TMP (populates the TmpPriceListName table using the data in 
PriceListData.txt file.)

■ CRMINTEG_TMP_TO_SEBL (populate the Siebel EIM tables from the Oracle EBS tables)

■ CRMINTEG_SEBLHEADERINC_TO_XREF

■ CRMINTEG_SEBLLINEINC_TO_XREF

To prevent possible duplicate records resulting from incremental loads, follow these guidelines:

■ If you are adding a new Price List then run these maps only:

■ CRMINTEG_SEBLHEADERINC_TO_XREF

■ CRMINTEG_SEBLLINEINC_TO_XREF

■ If you are adding only Line Items then run this map onlY:

■ CRMINTEG_SEBLLINEINC_TO_XREF

■ If you are updating line items do not run any maps at all.
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To import the price list data from EIM tables to Siebel base tables

1 Log in to a Siebel server.

2 Define the process for EIM tables to perform, for example import, by editing the configuration 
file that the process is based on.

The default configuration file is default.ifb, an ASCII text file with the extension .IFB that resides 
in the server\admin directory.

To define the process for price list data load, create a new EIM configuration file, PriceList.ifb, 
with the following details (modify Default Columns as needed for your implementation):

[Siebel Interface Manager]
LOG TRANSACTIONS = TRUE
PROCESS = Import Everything

[IMPORT_PRICELIST]
SESSION SQL = "UPDATE EIM_PRI_LST SET PL_EFF_END_DT = '2007-01-15' WHERE 
PL_ACTIVE_FLG = 'N' AND PL_EFF_END_DT IS NULL"
BATCH = 200
TYPE = IMPORT
TABLE = EIM_PRI_LST
ONLY BASE TABLES = S_PRI_LST, S_PRI_LST_ITEM, S_PRI_LST_BU

FIXED COLUMN = PL_ENTERPRISE_FLG, "N"
FIXED COLUMN = PLI_OVERRIDEROLLUP, "N"
FIXED COLUMN = PLI_PRI_CD, "STANDARD"
FIXED COLUMN = VIS_ACTIVE_FLG, "Y"
DEFAULT COLUMN = PL_BU, "Vision Operations"
DEFAULT COLUMN = VIS_BU, "Vision Operations"
DEFAULT COLUMN = PLI_PROD_BU, "Vision Operations"
DEFAULT COLUMN = PL_EFF_START_DT, "2007-01-15"
DEFAULT COLUMN = PLI_EFF_START_DT, "2007-01-15"

NOTE: If EIM has to be run for the same set of data, then first run EIM delete with the following 
configuration details.

delete.ifb

[Siebel Interface Manager]
LOG TRANSACTIONS = TRUE

[DELETE_PRICELIST]
TYPE = DELETE
BATCH = 200
TABLE = EIM_PRI_LST
DELETE MATCHES = S_PRI_LST,(INTEGRATION_ID IS NOT null)
DELETE MATCHES = S_PRI_LST_ITEM,(INTEGRATION_ID IS NOT null)
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3 Run the EIM process.

For price list data load, run EIM_PRI_LST with the PriceList.ifb EIM configuration file.

You can submit the EIM process as a Siebel server batch component task either from the 
Administration–Server Management views or from the Server Manager Command Line interface.

Use the following command to run EIM process:

start task for comp eim with config= <IFB Filename>, process=<Process Name As In IFB File>

TIP: This command to run EIM processes would translate as follows for price list data load:

start task for comp eim with config=PriceList.ifb, process="IMPORT_PRICELIST"

4 Verify results.

The EIM component task produces a trace log (EIN_task#.log). Once the EIM process is run, the 
records should have the status IMPORTED. Review records with status PARTIALLY_IMPORTED for 
potential data issues.

For more information on configuring the Siebel CRM environment, read Chapter 3, “Installation 
and Configuration.”

Loading Asset Data
Use the bulk load feature to move asset data (related to customer owned item instances) from the 
Oracle E-Business Suite into a Siebel CRM Asset.

Overview of Asset Data Bulk Load
Bulk loading of asset data is similar to that of other data types such as customer and product. The 
bulk load feature extracts asset data from Oracle E-Business Suite, transforms it into EIM interface 
table data structures, and moves it into the Siebel EIM interface tables. A Siebel loader program 
moves the data from the EIM interface tables into the application base tables of Siebel CRM.

Prerequisites for Loading Asset Data
Bulk loading of asset data has all the prerequisites for loading customer data. For more information 
read, Prerequisites for Loading Customer Data on page 71.

In addition, the process has the following extra prerequisites:

■ Make sure that customer, product, order, and business units and the related inventory locations 
are already synchronized. 

■ Create a list of values table in the OWB Repository for storing Oracle and Siebel asset status 
values. Use this script to create the table and load the values:
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Create table AssetStatusValues
(OracleStatus varchar2(50) primary key,
SiebelStatus varchar2(50));

insert into AssetStatusValues values('CREATED','Installed');
insert into AssetStatusValues values('EXPIRED','Obsolete');
insert into AssetStatusValues values('Latest','Production');
insert into AssetStatusValues values('Repaired','In Repair');
insert into AssetStatusValues values('Replacement','Suspended');
insert into AssetStatusValues values('Returned for Repair','In Transit');

■ Create a list of values table in the OWB Repository for storing Oracle and Siebel order types. Use 
this script to create the table and load the values:

Create table AssetOrderTypes
(OracleOrderType varchar2(50) primary key,
SiebelOrderType varchar2(50));

insert into AssetOrderTypes values('ORDER','Sales Order');
insert into AssetOrderTypes values('Mixed','Sales Order');
insert into AssetOrderTypes values('Return','Sales Order');

■ Create a flat table in the OWB Repository to serve as an intermediate store for Oracle-Siebel 
unique ID cross reference information. The bulk load feature uses this table to temporarily store 
cross reference data before loading it into the cross reference ID database. Every time the cross 
reference map is run, this table is cleaned and fresh data is loaded.

Use this script to create the table:

Create table XREF_DATA_FLAT
(XREF_GUID VARCHAR2(48),
ROW_NUMBER VARCHAR2(48),
XREF_ORCL_COLUMN_GUID VARCHAR2(48),
ORCL_VALUE VARCHAR2(4000),
XREF_SEBL_COLUMN_GUID VARCHAR2(48),
SEBL_VALUE VARCHAR2(4000),
XREF_COMM_COLUMN_GUID VARCHAR2(48),
COMM_VALUE VARCHAR2(4000),
IS_DELETED VARCHAR2(1),
LAST_CRUD_DATE VARCHAR2(100));

NOTE: If you have already created this table for the initial bulk load of other data types, you 
need not re-create it.

Loading Asset Data
The asset data bulk load involves:

1 To move asset data into EIM tables using the Oracle Warehouse Builder on page 91

2 To import the asset data from EIM tables to Siebel base tables on page 91

3 To populate Oracle-Siebel unique ID cross reference information for asset data on page 92

4 To update the Oracle E-Business Suite database on page 92
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To move asset data into EIM tables using the Oracle Warehouse Builder

1 Make sure that Oracle Warehouse Builder (OWB) is installed and operational.

For more information on installing and configuring the OWB Repository Runtime and Client, read 
Chapter 3, “Installation and Configuration.”

2 Start the OWB Design Center to connect to OWB Repository.

3 Navigate to Design > Import > Warehouse Builder Metadata.

4 Import the following file:

■ CRMINTEG_ASSET_EBS_TO_SEBL.mdl

The MDL provides an Expert, a wizard-based tool that guides you through the initial configuration 
steps. It also provides the initial design for bulk load.

5 After importing this file, import the results from EIM into the Siebel base tables as described in 
To import the asset data from EIM tables to Siebel base tables on page 91.

6 In OWB, navigate to Design > Import > Warehouse Builder Metadata.

7 Import the following files:

■ CRMINTEG_ASSET_SEBL_TO_XREF.mdl

■ CRMINTEG_ASSET_SEBL_TO_EBS.mdl

8 Proceed to To import the asset data from EIM tables to Siebel base tables on page 91.

To import the asset data from EIM tables to Siebel base tables

1 Log in to a Siebel application.

2 Define the process for EIM tables to perform, for example import, by editing the configuration 
file that the process is based on.

The default configuration file is default.ifb, an ASCII text file with the extension .IFB that resides 
in the server\admin directory.

To define the process for asset data load, create a new EIM configuration file, asset.ifb, with the 
following details:

[Siebel Interface Manager]
LOG TRANSACTIONS = TRUE
PROCESS = Import Everything

[IMPORT_ASSET]
TYPE = IMPORT
TABLE = EIM_ASSET
BATCH = 200
ONLY BASE TABLES = S_ASSET

FIXED COLUMN = AST_COMPUNDWRNTYFL, "N"
FIXED COLUMN = ASTCUSTOMIZABLEFLG, "N"
FIXED COLUMN = AST_PRODUNDWRNTYFL, "N"
FIXED COLUMN = AST_REFERENCEABLEF, "N"
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FIXED COLUMN = AST_SRLNUMVRFD_FLG, "N"
FIXED COLUMN = AST_TEST_ASSET_FLG, "N"

FIXED COLUMN = AST_UNDMFGWRNTYFLG, "N"

NOTE: If EIM has to be run for the same set of data, then first run EIM delete with the following 
configuration details.

delete.ifb

[Siebel Interface Manager]
LOG TRANSACTIONS = TRUE
[DELETE_ASSET]
TYPE = DELETE
BATCH = 100
TABLE = EIM_ASSET
DELETE MATCHES = S_ASSET,(INTEGRATION_ID IS NOT null)

3 Run the EIM process.

For asset data load, run EIM_ASSET with the asset.ifb EIM configuration file.

You can submit the EIM process as a Siebel server batch component task either from the 
Administration–Server Management views or from the Server Manager Command Line interface.

Use the following command to run EIM process:

start task for comp eim with config= <IFB Filename>, process=<Process Name As In IFB File>

TIP: This command to run EIM processes would translate as follows for asset data load:

start task for comp eim with config=Account.ifb, process="IMPORT_ASSET"

4 Verify results.

The EIM component task produces a trace log (EIN_task#.log). Once the EIM process is run, the 
records should have the status IMPORTED. Review records with status PARTIALLY_IMPORTED for 
potential data issues.

For more information on configuring the Siebel CRM environment, read Chapter 3, “Installation 
and Configuration.”

To populate Oracle-Siebel unique ID cross reference information for asset data
Use OWB to extract data from Siebel base tables and also to populate the key cross reference tables.

Execute the CRMINTEG_ASSET_SEBL_TO_XREF map to populate ID cross reference information.

NOTE: The ID cross reference information is later used during ongoing synchronization of asset 
information.

To update the Oracle E-Business Suite database
Execute the CRMINTEG_ASSET_SEBL_TO_EBS map to update the Oracle E-Business Suite database 
to mark all the records that were sent to Siebel CRM.
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5 Integrations
This chapter contains the following sections:

■ Overview of Integration Points on page 93

■ Customer Integration Point on page 94

■ Products Integration Point on page 109

■ Price List Integration Point on page 114

■ Asset Integration Point on page 115

■ Order Integration Point on page 117

Overview of Integration Points
The Siebel CRM Integration Pack for Oracle Order Management has two main elements; an initial 
loading of data from Oracle E-Business Suite (EBS) to Siebel Quote and Order Capture and the real-
time synchronization of data between the two applications.

The initial data load is usually done only once. For more information on the initial bulk load of 
business data, read Chapter 4, “Data Loading.” Real-time synchronization occurs when:

■ a new record is created in the Oracle E-Business Suite database.

■ a record that exists in both Oracle EBS and Siebel CRM databases is updated in either of the 
databases.

The real-time business data synchronization requires the integrations of these data types:

■ Customer. For more information, read “Customer Integration Point” on page 94.

■ Product. For more information, read “Products Integration Point” on page 109.

■ Price List. For more information, read “Price List Integration Point” on page 114.

■ Asset. For more information, read “Asset Integration Point” on page 115.

■ Order. For more information, read “Order Integration Point” on page 117.

Included with this documentation are mapping files for objects interchanged between Siebel CRM and 
Oracle EBS. This mapping files are provided in HTM format and are in a ZIP-formatted file named 
OrderManagementMappings.zip. The mappings included are:

■ Account-Sync_Comm2Siebel.htm

■ Account_Sync_Siebel2Comm.htm

■ Asset_Comm2EBS.htm

■ Asset_Comm2Siebel.htm
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■ BOM_Siebel2Comm2EBS.htm

■ Contact-Sync_Comm2Siebel.htm

■ Contact-Sync_Siebel2Comm.htm

■ CreditCheck_Siebel2Comm2EBS.htm

■ Order-Create_Siebel2Comm2EBS.htm

■ Order-Update_Comm2EBS.htm

■ PaymentAuth_Siebel2Comm2EBS.htm

■ Products_Siebel2Comm2EBS.htm

■ Quote_Siebel2Comm2EBS.htm

■ Shipping_Siebel2Comm.htm

Table 2 indicates the application connectivity from FMW and BPEL.

Customer Integration Point
Neither Oracle E-Business Suite nor Siebel CRM is the master database for customer data. 
Consequently, customer integration involves a two-way synchronization of customer data between 
the Oracle E-Business Suite database and the Siebel CRM database.

■ Overview of the Customer Data Integration Point on page 95

■ Prerequisites for Customer Data Integration on page 95

■ Synchronizing Customer Data from Oracle E-Business Suite to Siebel CRM on page 97

■ Synchronizing Customer Data from Siebel CRM to Oracle E-Business Suite on page 103

■ Notes on the Customer Integration Point on page 109

Table 2. Application Connectivity

Application Direction Mode Approach

Oracle EBS Inbound Asynchronous WF_IN JMS Queue or AQ

Synchronous EBS Adapter or DB Adapter calling PL/SQL APIs

Outbound Asynchronous EBS Events with AQ Adapter

Synchronous Web Service Call

Siebel CRM Inbound Asynchronous SOAP over JMS

Synchronous SOAP over HTTP

Outbound Asynchronous SOAP over JMS

Synchronous SOAP over JMS
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Overview of the Customer Data Integration Point
You need to synchronize customer data whenever a record that exists in both the Siebel CRM and 
Oracle EBS databases is updated in either database, or when a new record is created in the Oracle 
EBS database.

The customer data integration point includes:

■ Synchronizing Customer Data from Oracle E-Business Suite to Siebel CRM on page 97

■ Synchronizing New Customer Data from Oracle E-Business Suite to Siebel CRM on page 97

■ Synchronizing Updated Customer Data from Oracle E-Business Suite to Siebel CRM on page 100

■ Synchronizing Merged Customer Data in Oracle E-Business Suite to Siebel CRM on page 102

■ Synchronizing Inactivated Customer Data in Oracle E-Business Suite to Siebel CRM on page 102

■ Synchronizing Customer Data from Siebel CRM to Oracle E-Business Suite on page 103

■ Synchronizing New Customer Data from Siebel CRM to Oracle E-Business Suite on page 103

■ Synchronizing Updated Customer Data from Siebel CRM to Oracle E-Business Suite on page 106

Prerequisites for Customer Data Integration
Synchronization of customer data has the following prerequisites:

■ Oracle E-Business Suite 11.5.10 CU2 is installed on Oracle 9i (9.2.07) or newer database and 
you have the following responsibilities assigned to you:

■ Trading Community Manager

■ Oracle Customers Online Data librarian Superuser

These responsibilities provide you access to the following database objects:

■ HZ_CONTACT_POINTS

■ HZ_CUST_ACCOUNTS

■ HZ_CUST_ACCOUNT_ROLES

■ HZ_CUST_ACCT_SITES_ALL

■ HZ_CUST_SITE_USES_ALL

■ HZ_GEOGRAPHIES

■ HZ_GEOGRAPHY_IDENTIFIERS

■ HZ_LOCATIONS

■ HZ_ORG_CONTACTS

■ HZ_PARTIES

■ HZ_PARTY_SITES

■ HZ_PERSON_PROFILES
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■ HZ_RELATIONSHIPS

■ HR_OPERATING_UNITS

■ Oracle Warehouse Builder (OWB) 10.2 is installed on Oracle 9i (9.2.07) or newer database for 
OWB Deployment Target and repository creation.

■ You have SYS access to the database for OWB repository creation.

■ There is a directory in the file system on the same machine as the database to keep Domain 
Value Mapping (DVM) cross reference files.

■ The underlying BPEL process server is running.

■ Siebel 7.8.2.3 is installed on Oracle 9i (9.2.07) or newer database and you have access to the 
following database objects:

■ EIM_ACCOUNT

■ EIM_CONTACT

■ S_ADDR_ORG

■ S_CONTACT

■ S_ORG_EXT

■ You have set profile options as described in Table 3.

.

NOTE: The Siebel CRM O2C Integration Account WSDL Location, Siebel CRM O2C Integration Contact 
WSDL Location, and Siebel CRM O2C Integration Lead WSDL Location profile options must point to 
the BPEL server location.

■ You have a cross reference ID population database on which you have read and write access to 
XREF_DATA.

Table 3. Customer Data Integration Profile Options

Profile Site Level User

HZ: Raise API Events Yes No

HZ: Enable Duplicate Prevention at Party Yes Yes

Oracle Applications Look and Feel No No

Siebel CRM O2C Integration Account WSDL Location Yes Yes

Siebel CRM O2C Integration Contact WSDL Location Yes Yes

Siebel CRM O2C Integration Lead WSDL Location Yes Yes
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Synchronizing Customer Data from Oracle E-Business 
Suite to Siebel CRM
Synchronize customer data from the Oracle EBS database to the Siebel CRM database after you have, 
in Oracle EBS:

■ Created a new customer record. For more information, read “Synchronizing New Customer Data 
from Oracle E-Business Suite to Siebel CRM” on page 97.

■ Updated a customer record that exists in both the Siebel CRM and Oracle EBS databases. For 
more information, read “Synchronizing Updated Customer Data from Oracle E-Business Suite to 
Siebel CRM” on page 100.

■ Merged customer data that existed in both the Siebel CRM and Oracle ESB databases. For more 
information, read “Synchronizing Merged Customer Data in Oracle E-Business Suite to Siebel CRM” 
on page 102.

■ Inactivated customer data that existed in both the Siebel CRM and Oracle EBS databases in 
Oracle EBS. For more information, read “Synchronizing Inactivated Customer Data in Oracle 
E-Business Suite to Siebel CRM” on page 102.

NOTE: Only newly created or updated Oracle Organization parties and Organization contacts that 
are associated with an account in Oracle EBS need to be synchronized to Siebel CRM. Do not 
synchronize Persons parties (whether associated with an account in Oracle EBS or not) that do not 
have a relationship to an organization.

Synchronizing New Customer Data from Oracle E-Business Suite to 
Siebel CRM
You can create a new customer record through the UI of Oracle EBS applications or EBS public APIs. 
You must then synchronize the Oracle EBS database to the Siebel CRM database to create a 
corresponding account in Siebel CRM and maintain data integrity between the databases. For more 
information, read “To synchronize new or updated customer data from Oracle E-Business Suite to Siebel 
CRM” on page 102.
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Figure 4 illustrates the synchronization of new customer data from Oracle EBS to Siebel CRM 
databases.

Figure 4. Synchronization of New Customer Data from Oracle EBS to Siebel CRM Databases
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Figure 5 provides more details on the synchronization flow of new customer data from Oracle EBS to 
Siebel CRM databases. It shows BPEL process CRMIntegSaveAcctEBS11i10ToSEBL782Sync.

Figure 5. Detailed New Customer Data Synchronization Flow from Oracle EBS to Siebel CRM 
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Synchronizing Updated Customer Data from Oracle E-Business Suite 
to Siebel CRM
Synchronize the Oracle E-Business Suite database to Siebel CRM database whenever you update an 
existing customer record in E-Business Suite. The synchronization flow for updated customer data is 
similar to the synchronization flow for new customer data. For more information, read “To synchronize 
new or updated customer data from Oracle E-Business Suite to Siebel CRM” on page 102.

Figure 6 illustrates the data synchronization to reflect updates to an existing customer record in 
Oracle E-Business Suite.

Figure 6. Synchronization of Updated Customer Data from Oracle to Siebel Database
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Figure 7 provides more details on the synchronization flow of updated customer data from Oracle EBS 
to Siebel CRM databases.

Figure 7. Detailed Updated Customer Data Synchronization Flow from Oracle EBS to Siebel CRM
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To synchronize new or updated customer data from Oracle E-Business Suite to 
Siebel CRM

1 Create or update a customer in Oracle EBS.

2 Run the TCA Business Object Events: Raise Events Program concurrent request.

This concurrent request invokes the BPEL process in the integration middleware. The integration 
middleware BPEL process:

1 Transforms an Oracle object to a common object.

2 Transforms a common object to a Siebel object.

3 Invokes the Siebel Web Service that creates the corresponding Siebel account.

4 Retrieves the unique Siebel internal account, address, and contact IDs from the Siebel Web 
Service.

5 Inserts them into the cross reference ID population database.

For a detailed illustration of the synchronization flow, see Figure 5 and Figure 7.

Synchronizing Merged Customer Data in Oracle E-Business Suite to 
Siebel CRM
Oracle E-Business Suite is the master database for the customer merge data. Both party and account 
merges happen only in Oracle E-Business Suite, after which the customer data is synchronized from 
Oracle E-Business Suite to Siebel CRM.

Depending on the type of the merge:

■ The Merge From account is deleted from Siebel CRM.

■ The Merge To account reflects the customer data from the From account.

For more information on the synchronization process, read “To synchronize new or updated customer 
data from Oracle E-Business Suite to Siebel CRM” on page 102.

NOTE: Data merge in Oracle E-Business Suite affects only the entries that exist in both Oracle EBS 
and Siebel CRM databases. For example, data merge in Oracle EBS does not affect Siebel CRM data 
if the Merge From and To accounts do not exist in the Siebel CRM database.

Synchronizing Inactivated Customer Data in Oracle E-Business Suite 
to Siebel CRM
In Oracle E-Business Suite, you can inactivate customer data, such as parties, customer accounts, 
addresses, and contacts. You need to synchronize all such inactivation to Siebel CRM. For more 
information on the synchronization process, read “To synchronize new or updated customer data from 
Oracle E-Business Suite to Siebel CRM” on page 102.

When you have inactivated a record in Oracle E-Business Suite, you cannot book any new orders in 
Siebel CRM that refers to the inactivated Oracle EBS record.
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Synchronizing Customer Data from Siebel CRM to Oracle 
E-Business Suite
Synchronize customer data from the Siebel CRM database to the Oracle EBS database after you have, 
in Siebel CRM:

■ Created a new customer record in the context of managing an order submitted for that customer. 
For more information, read “Synchronizing New Customer Data from Siebel CRM to Oracle 
E-Business Suite” on page 103.

■ Updated a customer record that exists in both the Siebel CRM and Oracle EBS databases in the 
context of managing an order submitted for that customer. For more information, read 
“Synchronizing Updated Customer Data from Siebel CRM to Oracle E-Business Suite” on page 106.

NOTE: You do not need to synchronize customer data from the Siebel CRM database to the Oracle 
EBS database every time you create a new customer record in Siebel CRM, or add details, such as 
address and contacts, to a customer record in Siebel CRM that exists in both the Siebel CRM and 
Oracle EBS databases. You need to synchronize such customer data from the Siebel CRM database 
to the Oracle EBS database only when they are used to manage an order.

Synchronizing New Customer Data from Siebel CRM to Oracle 
E-Business Suite
When you create and submit an order from Siebel CRM, a workflow process in the integration 
middleware checks whether or not the customer, contact, and address records related to the order 
exist in Oracle E-Business Suite. If the record does not exist in Oracle EBS, a customer creation flow 
and data synchronization flow is initiated.
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Figure 8 illustrates the customer creation flow and data synchronization flow at a high level.

Whenever you create a new customer record in Siebel CRM in the context of managing an order 
submitted for that customer, you must synchronize the Siebel CRM database to the Oracle EBS 
database to create a corresponding record in Oracle EBS and maintain data integrality between the 
databases. For more information, read “To synchronize new customer data from Siebel CRM to Oracle 
E-Business Suite” on page 106.

NOTE: A new account created in the context of managing a Siebel CRM order creates a party and a 
customer account in the Oracle E-Business Suite database. An account address created in the same 
context creates a location, party site, account site, and site uses in the organization in which the 
order is going to be created in Oracle EBS. Only the new addresses and address roles of the account 
being used in the order are created. An account contact from Siebel CRM creates a Person party, 
organization contact, and account contact in Oracle EBS.

Figure 8. Creation of New Customer Data and its Synchronization from the Siebel CRM Database 
to the Oracle EBS Database
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Figure 9 provides more details on the synchronization flow of new customer data from the Siebel CRM 
database to the Oracle EBS database.

Figure 9. Detailed New Customer Data Synchronization Flow from the Siebel CRM Database to the 
Oracle EBS Database
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To synchronize new customer data from Siebel CRM to Oracle E-Business Suite

1 Create a new order in Siebel CRM using a newly created or existing account or contact.

2 Submit the order to Oracle EBS.

Submitting the order to Oracle EBS initiates a workflow process that calls an integration 
middleware BPEL process for Organization customer account or contact creation. The integration 
middleware BPEL process:

1 Transforms the Siebel order message object to a common object.

2 Transforms the common object to an Oracle object.

3 Invokes the Oracle API/Web Service that creates the corresponding Oracle Organization 
customer account or contact.

4 Retrieves the unique Oracle internal Organization customer account, address, and contact 
IDs from Oracle API/Web Service.

5 Inserts these Oracle IDs into the cross reference ID population database.

6 Processes the order using Oracle IDs.

For a detailed illustration of the synchronization flow, see Figure 9.

Synchronizing Updated Customer Data from Siebel CRM to Oracle 
E-Business Suite
Synchronize updated customer data from the Siebel CRM database to the Oracle EBS database only 
if the following conditions are met:

■ The updated customer record exists in both the Siebel CRM and Oracle EBS databases.

■ The new details, such as addresses and contacts, were added to such a customer record in Siebel 
CRM in the context of managing an order submitted for that customer.
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Figure 10 illustrates the data synchronization to reflect updates to an existing customer record in 
Siebel CRM.

Figure 10. Synchronization of Updated Customer Data from the Oracle EBS Database to the Siebel 
CRM Database
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Figure 11 provides more details on the synchronization flow of updated customer data from the 
Siebel CRM database to the Oracle EBS database.

Figure 11. Detailed Updated Customer Data Synchronization Flow from the Siebel CRM Database to 
the Oracle EBS Database
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To synchronize updated customer data from Siebel CRM to Oracle E-Business Suite

1 Create a new order in Siebel CRM for a customer using details, such as addresses and contacts, 
that are newly added to the customer record.

2 Submit the order to Oracle EBS.

Submitting the order to Oracle EBS initiates a workflow process that calls an integration 
middleware BPEL process for updating the customer record in EBS. The integration middleware 
BPEL process:

1 Transforms the Siebel order message object to a party common object.

2 Transforms the party common object to an Oracle object.

3 Invokes the Oracle update Web Service that updates the corresponding Oracle Organization 
customer account.

4 Retrieves the unique Oracle internal Organization customer IDs from Oracle update Web 
Service.

5 Inserts them into the cross reference ID population database.

6 Processes the order using Oracle IDs.

For a detailed illustration of the synchronization flow, see Figure 11.

Notes on the Customer Integration Point
■ If the account sites created from APIs using a party-site that does not belong to the party that 

owns the account, then those account sites do not synchronize properly.

■ The Delete After Merge option should be set to YES (checked). If it is not set to this value, the 
corresponding account in Siebel CRM is deleted, but on addition of another new account in Oracle 
EBS for the same party is recreating the deleted account in Siebel CRM with a status of Inactive.

■ While the format of phone numbers is checked for correctness upon entry in Siebel CRM, 
validations are not performed on entries to the phone number and fax number fields in Oracle 
EBS. When a Siebel CRM user accesses a Contact or Account Contact in Siebel CRM which has 
been populated from an Oracle-created customer record, Siebel CRM could display the following 
message:

Error:: Wrong Field values or value types detected  in field Main phone#

Products Integration Point
Oracle E-Business Suite is the master database for product-related data. Consequently, product 
integration involves a one-way synchronization of product data, from Oracle E-Business Suite to 
Siebel CRM.

■ Overview of the Product Data Integration Point on page 110

■ Prerequisites for the Product Data Integration Point on page 110

■ Synchronizing Simple Product (Item) Data on page 111
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■ Synchronizing Complex Product (BOM) Data on page 113

Overview of the Product Data Integration Point
Product data integration is the process of synchronizing Oracle EBS and Siebel CRM product 
definitions.

Oracle E-Business Suite stores product definitions under these categories:

■ Simple products or Items. A product that does not any have components. Anything you buy, 
sell, or handle in your business. An item may be a tangible item in your warehouse, such as a 
wrench or tractor, or an intangible item, such as a service. Simple products are stored in Siebel 
CRM with the structure Bundle.

■ Complex products or bills of materials (BOM). A list of component items associated with a 
parent item and information about how each item relates to the parent item. Complex products 
are stored in Siebel CRM with the structure Customizable.

You need to synchronize product data after you have, in Oracle E-Business Suite:

■ Created a simple (item) or complex (BOM) product record.

■ Updated a simple (item) or complex (BOM) product record that exists in both the Siebel CRM and 
Oracle EBS databases.

NOTE: Although the hierarchical structure of a complex configurable product (BOM) is available in 
Siebel CRM, the structure is read-only in Siebel CRM and is maintained in Oracle E-Business Suite. 
Consequently, you can modify the structure of the configurable product only in Oracle E-Business 
Suite.

Product data integration includes:

■ Synchronizing Simple Product (Item) Data on page 111

■ Synchronizing Complex Product (BOM) Data on page 113

Prerequisites for the Product Data Integration Point
Synchronization of product data has all the prerequisites for synchronizing customer data. For more 
information read, “Prerequisites for Customer Data Integration” on page 95.

In addition, the process has the following extra prerequisites:

■ The simple and complex products can be ordered by customers. They have the check boxes for 
Customers Ordered and Customer Orders Enabled order management attributes selected.

■ (BOM only) A product structure request has been raised in Siebel CRM.

■ Users of Oracle EBS must have Oracle Inventory responsibility to create new items.
Siebel CRM Integration Pack for Oracle Order Management Implementation 
Guide  

110 



Integrations ■ Products Integration Point
Synchronizing Simple Product (Item) Data
Synchronize simple product (item) data from Oracle EBS to Siebel CRM after you have, in Oracle EBS:

■ Created a new simple product (item) record.

■ Updated a simple product (item) record that exists in both the Siebel CRM and Oracle EBS 
databases.

Synchronizing simple product data is the process of replicating a new or updated simple product from 
Oracle EBS into Siebel CRM as a configurable product without any dependencies.

For more information, read “To synchronize new or updated simple product (item) data” on page 112.

Figure 12 illustrates, at a high level, the simple product create/update flow and the corresponding 
data synchronization from Oracle E-Business Suite to Siebel CRM.

Figure 12. Synchronization of Simple and Complex Product Data from Oracle EBS to Siebel CRM
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To synchronize new or updated simple product (item) data

1 Create or update an item in Oracle E-Business Suite with the check boxes for Customers Ordered 
and Customer Orders Enabled order management attributes selected.

A product is available in Siebel CRM only if the check boxes for the Customers Ordered and 
Customer Orders Enabled order management attributes are selected.

2 Save the product.

Saving the product triggers an item business event that calls an integration middleware BPEL 
process. The integration middleware BPEL process: 

1 Extracts the definition of the simple product from Oracle E-Business using the Oracle Simple 
Product Web Service and Oracle E-Business Suite (EBS) Adapter.

2 Transforms the simple Oracle product message to a common object. 

3 Transforms the common object to a Siebel object.

4 Invokes the Siebel Simple Product Web Service that creates or updates the simple product in 
Siebel CRM as a bundle.

5 Siebel CRM creates a version of the product definition for each update.

A product is available in Siebel Sales Order only if it has a version.

6 Retrieves the unique Siebel product IDs from Siebel Simple Product Web Service.

7 Inserts Oracle-Siebel unique ID cross reference information into the cross reference ID 
population database.

For a detailed illustration of the synchronization flow, see Figure 12. Tab shows the mapping of major 
data elements between Oracle EBS and Siebel CRM.

Table 4. Product Mapping between Oracle EBS and Siebel CRM

Oracle E-Business Suite Siebel CRM

Item Number: Organization Code Product Name

Item Long Description Description

Customer Orders Enabled Orderable Flag

Organizations Locations

Operating Unit Organizations

Primary Unit of Measure UOM

BOM Item Type: Standard, Option class, planning, product family Structure: Bundle

BOM Item Type: Model Structure: Customizable
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Synchronizing Complex Product (BOM) Data
Synchronize complex product (BOM) data from Oracle to Siebel database after you have, in the 
Oracle E-Business Suite:

■ Created a new complex product (BOM) record.

■ Updated a complex product (BOM) record that exists in both the Siebel and Oracle databases. 

Synchronizing complex product data is the process of replicating a new or updated bill of material 
(BOM) from Oracle into Siebel CRM as a configurable or customizable product.

NOTE: You do not need to synchronize complex product (BOM) data from Oracle EBS to Siebel CRM 
every time you create a new bill of material (BOM) in Oracle EBS, or update components and 
relationships of an existing BOM. You need to synchronize only those BOMs for which a product is 
defined as a Bundle/Kit in Oracle EBS and the Siebel Pricing Administrator wants to implement the 
Siebel Hierarchical Pricing on the same or any other feature of Siebel Advance Pricing that needs the 
Hierarchy to be present in Siebel CRM.

A Siebel CRM user typically:

■ Synchronizes the parent product of the BOM, the simple product to which the BOM is attached, 
to Siebel CRM using the Synchronize Simple Product business process.

■ Uses the Request Configurable Product business process to fetch the configurable complex 
product data into Siebel CRM.

For more information, see Figure 12 and read “To synchronize new or updated complex product (BOM) 
data” on page 113.

To synchronize new or updated complex product (BOM) data

1 Create or update a complex or configurable product (BOM) in Oracle EBS.

a In the Master Item window of Oracle Inventory, create a parent item and the items to be used 
as components in the bill of material (BOM) as children of the parent item. While creating the 
items: 

❏ Make sure that you select the check boxes for the Customers Ordered and Customer 
Orders Enabled order management attributes.

❏ Make sure that you select Model as the bill of material BOM Item Type attribute, so that 
the item is identified as a customizable (configurable) product in Siebel CRM.

b Create a bill of material (BOM) for the parent product or item in the Bills of Material window of 
the Oracle BOM application module.

2 Navigate to Siebel CRM > Administration – Product > Product Definition.

3 Search for the parent product in Siebel CRM.

4 Refresh the product.

Refreshing the product calls a workflow that triggers an integration middleware BPEL process. 
The integration middleware BPEL process:
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a Retrieves the details of the parent product from Siebel CRM, such as Siebel Product ID, Inventory 
Location ID, and Business Unit ID, using the Siebel Complex Product Web Service.

b Invokes the Oracle Complex Product Web Service and Oracle E-Business Suite (EBS) Adapter, 
which use the details of the parent product, to query and extract related bill of material (BOM) 
information, such as components and relationships.

c Invokes the Siebel Complex Product Web Service, which uses the BOM information extracted 
from Oracle E-Business, to update the definition of the parent product in Siebel CRM with a new 
version. In the new version, the structure of the product is customizable.

d Retrieves Oracle-Siebel unique ID cross reference information, such as Product ID, Inventory 
Location ID, and Business Unit ID of the parent and component items.

e Inserts Oracle-Siebel unique ID cross reference information into the cross reference ID 
population database.

❏ The simple product must exist in Siebel prior to synchronization of the bill of material

❏ Disabled components in the Oracle EBS bill of material are not synchronized.

❏ Only the current effective bill of materials are synchronized.

For a detailed illustration of the synchronization flow, see Figure 12.

Price List Integration Point
The Price list integration point is different from that of other data types, such as customer and 
product. You can use the bulk load feature to synchronize changes to active price list data in the 
Oracle E-business Suite database to the Siebel CRM database. These changes after the initial bulk 
load could be either creation of new price lists or updates to the header and line information of 
existing price lists.

The incremental bulk loads create or update price lists or the header and line information in the 
Siebel CRM database, depending on whether or not the price lists or the header and line information 
already exist in that database.

If you change the name of a price list in Oracle EBS, a new price list with that name is created in 
Siebel CRM. Siebel CRM does not delete or rename the original price list. You can do that manually 
if needed.

If Pricing Security is turned on and if a price list not global you need to initialize the context in Oracle 
EBS before synchronizing price list lines. To initialize, use the CRMINTEG_PRICELIST_V view and use 
the following statement:

fnd_global.apps_initialize(<User Id>, <Responsibility Id>,<Application id>);
For example: fnd_global.apps_initialize(1318, 24021, 661);

A price list can be made non-global by clearing the Global checkbox in the Oracle EBS price list 
screen. A non-global pricelist can be used only in the operating unit set in the Oracle EBS profile 
MO:Operating Unit.
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Asset Integration Point
Oracle E-Business Suite is the master database for asset data. Consequently, asset integration 
involves a one-way synchronization of asset data, from the Oracle E-Business Suite database to the 
Siebel CRM database.

■ Overview of the Asset Data Integration Point on page 115

■ Prerequisites for the Asset Data Integration Point on page 115

■ Synchronizing Asset Data on page 115

Overview of the Asset Data Integration Point
When an ordered item is shipped as part of an order fulfillment, that item is created in Oracle 
E-Business Suite as a customer-owned item instance. Asset data integration is the process of 
synchronizing new or updated customer owned item instances from Oracle E-Business Suite into a 
Siebel CRM Asset.

Prerequisites for the Asset Data Integration Point
Synchronization of asset data has the same prerequisites as for loading customer data. For more 
information read, “Prerequisites for Customer Data Integration” on page 95.

Synchronizing Asset Data
You need to synchronize asset data after:

■ An item is created in Oracle E-Business Suite as a customer owned item instance.

■ A customer owned item instance is updated in Oracle E-Business Suite.

For more information, read “To synchronize new or updated asset data” on page 117.
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Figure 13 illustrates, at a high level, the asset data (customer owned item instances) synchronization 
flow from Oracle E-Business Suite to Siebel CRM.

Figure 13. Asset Synchronization Flow from Oracle EBS to Siebel CRM
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To synchronize new or updated asset data

1 Create or update a customer owned item instance.

Creating or updating a customer owned item instance raises a business event that initiates an 
integration middleware BPEL process. The integration middleware BPEL process:

1 Transforms an Oracle message to an Installed Product common object.

2 Transforms an Installed Product common object to a Siebel Asset object.

3 Invokes the Siebel Asset - Synchronize Web Service that creates or updates asset data in 
Siebel CRM Asset.

4 Retrieves unique Siebel Asset IDs.

5 Inserts Oracle-Siebel unique ID cross reference information into the cross reference ID 
population database.

For a detailed illustration of the synchronization flow, see Figure 13.

Order Integration Point
You can create orders and quotes in Siebel Order Capture, and the application creates and fulfills 
orders in Oracle Order Management. The integration applies to new orders and quotes, orders with 
configured and non-configured products, and RMAs. The integration pack loads and updates 
customer information that includes accounts, account sites, and contacts when a Siebel order or 
quote is submitted.

The Orders and Quotes Integration consists of the following integration components:

■ Notes on the Order Integration Point on page 117

■ Orders and Quotes on page 121

■ Oracle Configurator Integration on page 123

■ Available To Promise (ATP) on page 124

■ Credit Check on page 125

■ Payment Authorization on page 126

■ Shipping Charges on page 127

■ Pricing, Tax, and Invoicing on page 127

Notes on the Order Integration Point
■ When a configured product is split in Oracle EBS Order Management, only the root level 

configuration item is split in Siebel CRM and the newly created line in Siebel CRM has a price of 
$0.
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■ An order where the contacts being used for the order are shared by another account (not being 
used in the order) is not supported. The synchronization of this account to Oracle EBS may 
produce errors, and correspondingly the synchronization of the order fails. Contacts which are 
not initially shared become shared by transactions in Siebel CRM.

■ Users that have visibility to multiple business units in Siebel need to know which product to pick 
for a specific organization in Oracle EBS. For example an item with the name Sample:V1 in the 
V1 Organization in Oracle EBS creates a product with the name Sample:V1:12345 in Siebel CRM. 
If the same item Sample:V1 when assigned to Org M1 in the EBS side causes another product 
with name Sample:V1:67890 to be created in Siebel CRM. In this case, the user would needs to 
know that Sample:V1:67890 is from Org M1.

■ In some situations, an account may get created and committed into Oracle EBS even though the 
order that was using the account may have errors in synchronization.

Figure 14 illustrates the Order Create flow.

Figure 14. Oracle EBS to Siebel CRM Order Flow
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Figure 15 illustrates the Order Update flow.

Figure 15. Oracle EBS to Siebel CRM Update Order Flow
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Figure 16 illustrates the Order Update flow.

Figure 16. Detailed Flow for Order Changes and Updates
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Orders and Quotes
The following rules apply when creating orders in Siebel Order Capture, and using the Update Order 
Integration Process:

■ Within the Siebel CRM to Oracle EBS Order Management integrated flow orders are always 
created with a Booked status in Oracle EBS Order Management.

■ You can update an order in Siebel Order Capture only when the Siebel order is in Entered status.

■ You can disable updates in Siebel Order Capture by updating the Integration ID after the order 
is in Siebel Order Capture or Oracle Order Management.

■ If a quote is created in Siebel Order Capture and then synchronized to Oracle Order Management, 
then the quote life cycle ends at Siebel and no further updates are supported from Oracle Order 
Management to Siebel Order Capture.

■ You can delete orders and order line items if the Siebel CRM order is in Entered status (has not 
been synchronized to the back office).

■ Order Synchronization occurs only when Credit Check status has not put the order on hold. Non- 
calculation of shipping charges and payment authorization does not prevent the order from being 
submitted. Calculated Shipping charges are not carried forward to back office and tax calculation 
is done in the back office.

■ Product Id and Price List Id is available prior to calling the Order Synchronization. If these are 
not synchronized, then the process fails.

■ The integration server sets the Value XREF for both Siebel and Oracle Values.

■ Any updates to an order in Oracle Order Management are system driven as manual updates are 
not recommended.

During the process of fulfilling an order, the order may go through several changes and updates in 
Oracle Order Management, and these changes are required to be synchronized with the Siebel Order 
Capture application.

If any of the following attributes of an order line change, then a business event is raised from Oracle 
Order Management that synchronizes the order in the Siebel Order Capture application:

■ Order Header/Line Status

■ Order Header/Line Hold/Hold Release

■ Line Split (Only system splits caused due to partial shipping / receiving)

■ Line Schedule Arrival Date change

■ Line Schedule Ship Date change

■ ATO Models: In the case of ATO (Assemble to Order) Models the configured item line created in 
Oracle EBS Order Management is not synchronized back to the Siebel CRM order. However the 
status of the configured item line in Oracle EBS Order Management is synchronized back to the 
status of the Model line within the Siebel CRM order.

■ Payment Authorization: In the Siebel CRM > Oracle EBS Order Management integrated flow, only 
Order Level Payments are supported. Also only a Payment Type of Credit Card is supported.
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■ Line Statuses: The following table shows the pre-seeded statuses that are supported and the 
corresponding cross references within the Siebel > EBS Order Management integrated flow.

NOTE: The statuses of Awaiting Fulfillment and Supply Eligible may be sent by Oracle EBS but they 
are ignored by Siebel CRM. The Hold Reason is not sent by Oracle EBS. When a Line Level Hold is 
sent, the status is not changed to Hold. The Picked status in Oracle EBS is not equivalent to the 
Picked status in Siebel CRM. For RMAs the Awaiting Return Disposition status in Oracle EBS can be 
mapped to a status that you create in Siebel CRM.

To create an order or quote for a standard item from Siebel Order Capture to Oracle 
Order Management

1 From the Siebel Order window or Siebel Quote window, create an order or quote for a standard 
item.

2 Make sure Order Status is Booked.

3 Click Submit Order.

A Siebel workflow captures the Order and transfers the order data to Oracle Order Management 
and creates a sales order or RMA order in Oracle Order Management.

4 Verify sales order synchronization with Oracle Order Management.

The Status on the Siebel order changes from New to Submit-Pending.

5 Querying the Order in EBS Order Management:

a Use the Order Organizer in Order Management to query using any of the methods listed below:

❏ Based on Order Source: Siebel Order / Siebel Quote

❏ Based on Order Source Number:28 for Order & 29 for Quote

❏ Order number:

❏ Combination of the above

For additional details refer to the Order Management Users Guide.

NOTE: RMAs are processed through service orders within Siebel Service.

Siebel CRM Oracle EBS

Booked Booked

Picked Awaiting Shipping

Shipped Shipped

Complete Fulfilled (For outbound lines) 

Closed Closed
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Oracle Configurator Integration
Oracle Configurator is included as an integral component of the Siebel Order Capture to Oracle Order 
Management flow, making sure that quotes are accurate and valid at the time that they are created.

■ Oracle Configurator is launched directly from a Siebel Quote, Order, Agreement or from a user’s 
list of favorites.

■ End users can be guided by interactive needs assessment during the configuration process.

■ Oracle Configurator is also integrated with Siebel Eligibility, Compatibility, and Pricing rules.

■ Configuration model structure, rules, and user interfaces are created and maintained in Oracle 
Configurator Developer using Oracle E-Business Suite product data. For more information, read 
the Oracle Configurator documentation.

■ Configuration model developers can create guided selling structure in addition to the product 
data structure.

■ Users are able to write configuration rules with Oracle Configurator Developer, including 
Configurator Extensions.

■ Companies are able to fully customize the look, feel, and flow of each runtime user interface to 
meet any unique requirements of their multiple sales channels.

■ Deletion of an order line that is part of a customizable is not allowed. The Oracle Configurator 
must be used to change the options on a customizable product.

Figure 17 show the Configurator architecture.

To run Oracle Configurator

1 Add a configurable product from Siebel Product Master to a Siebel quote.

2 Specify the customer and price list.

Figure 17. Architecture of Configurator in This Integration
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3 Click Customize.

This launches Oracle Configurator 

4 To return to Siebel Quote, click Done in Oracle Configurator.

The selections that were made in the configuration session synchronized with those in Siebel 
Product Master, and all quantities, pricing, and eligibility statuses are displayed accordingly. 

Available To Promise (ATP)
The Available To Promise (ATP) inquiry occurs prior to order submit, and returns availability 
information from Oracle when the request is executed from Siebel Order Capture.

You can check ATP quantities from Siebel CRM and retrieve availability details from Oracle Global 
Order Promising (GOP) through an ATP Application Program Interface (API). You can initiate the ATP 
inquiry from Siebel CRM to obtain product availability, quantity, and scheduled ship date from Oracle 
EBS using the EBS Web service. The Product id, requested date, and quantities are sent to the Oracle 
EBS API to check available inventory. The API returns a promised date and quantity, or presents 
multiple promised dates if the desired quantity is not available on the requested date. Siebel CRM 
displays this data so the customer service representative can update the customer and continue 
processing the order. ATP is not applicable for Complex Products

You can request ATP dates for an order line or an entire order from the Siebel Order window.

The ATP Inquire and Inquire All buttons in the Siebel Order window trigger the workflow and initiate 
the process that runs the Request ATP Check business process. The Inquire button sends an ATP 
check request for a single line item, and the Inquire All button sends an ATP check request for all 
line items on an order.

To request ATP inquiry

1 From the Siebel Order window, click the Orders tab.

2 Search for a pending order.

An order item appears on the line item applet.

3 In the Order window, click the Fulfillment tab.

A line item appears on line item applet.

4 Navigate to the line items applet.

The promise schedule lines applet and request schedule line applet appear at the bottom of the 
window.

5 Select a single line item.

6 Click Inquire on the Line Item Applet to check the availability of the current line item, or click 
Inquire All to check the availability of all line items for the order.
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Notes on the ATP Check Integration Point
■ Available Quantity at the line level is displayed only when the Available Status is Available. For 

any other status the value at line level is 0 (zero). If Available Status is Out of Stock or ATP not 
applicable or Plan not found, then the Available quantity displayed at the line level is 0(zero), 
and the actual Available quantity is displayed at the Promise Line Level.

■ The default requested date shown in the Siebel CRM fulfillment window is the system date plus 
one day. This value is used for the ATP inquire and the resultant availability reflects this date.

■ The following table shows examples of sourcing rules setup in Oracle EBS and the resulting return 
values. These examples assume the site and user level product are consistent.

Credit Check
The Request Credit Check process occurs prior to order submit. You can execute the Request Credit 
Check Business Process from the Siebel Order window for a customer and the purchase order 
amount. Siebel CRM obtains credit check status from Oracle EBS.

If the response is Failed, then the hold flag is set to true, and the Purchase Order Payment Status is 
set to Rejected. The Rejected status sets the order to hold status, and you must remove the hold 
status before you can submit the order.

The Request Credit Check button in the Siebel Order window triggers the workflow that initiates the 
process and runs the Request Credit Check business process. The Credit Check button sends a Credit 
Check request for an account and order.

To request credit check

1 Navigate to the Siebel Order window and select All Sales Orders Across Organizations.

2 From the Sales tab, click Query and select a sales order with a status of Pending for a customer.

3 Navigate to the Payments applet and select Payment Lines.

4 Click the New button on the Payment Lines tab.

Example
Oracle EBS 
Return Value

Siebel CRM 
Return Value

Case1: No sourcing rule defined No sources 
defined

Problem with ATP

Case2: Sourcing rule is defined: (Transfer from V1 100 
Rank1, Transfer from M1 100 Rank2) and both sources 
have availability.

Returns V1 as 
source

Returns V1 as 
source

Case3: Sourcing rule is defined: (Transfer from V1 100 
Rank1, Transfer from M1 100 Rank2) Rank2 source M1 
has availability and V1 does not.

Returns M1 as 
source

Returns M1 as 
source
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5 Enable Payment Method and select Purchase Order.

NOTE: The Credit Check button appears on the Payment Detail applet when you select Purchase 
Order as the Payment Method

6 Click out of the applet to save information.

7 Navigate to the Payment Detail - Purchase Order applet. The Transaction Amount field equals the 
Transaction Amount field from the Payment Lines applet. Credit Status, Credit Status As Of, and 
Credit Check Message fields are gray and set to NULL.

8 Click Credit Check at the top of the applet. Customer credit information is returned to Siebel CRM 
from Oracle EBS.

If the Credit check is successful the Payment status field should indicates APPROVED.

Payment Authorization
You can run the Request Payment Authorization business process prior to the Create Order process. 
The Request Payment Authorization business process is executed from the Siebel application, and 
captures credit authorization status from Oracle EBS.

Credit card details and order amounts are processed by the Oracle EBS API to authorize the payment 
for the order amount. The Oracle EBS API returns a message indicating if the amount was processed 
against the credit card, or if it failed authorization. This data is returned to Siebel CRM so the 
customer support representative can update the customer on the status, and then submit the order 
to Oracle Order Management for fulfillment. The process supports only one credit card per order. 
Orders are not sent to Oracle order Management until payment authorization is successful, if the 
Payment Authorization business process is invoked before order submission. You can still submit the 
order to Oracle Order Management without invoking payment authorization business service.

To request Siebel CRM payment authorization

1 Navigate to the Siebel Payments window.

2 Enter specific payment attributes such as credit card type, credit card number, credit card holder, 
expiry month and expiry year.

3 Click Authorize.

If successful, the authorization code and date display.

Additional credit card information that needs validation needs to be customized at the customer site 
level. The following are the additional validations that need to be implemented.

■ Validating that the Name is entered and not null.

■ Address is not null.

■ Merchant ID is set.

In the case of a rejection you need to enter valid data based on the validation requirements that you 
have implemented.
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Shipping Charges
You can run the Request Shipping Charges prior to the Create Order process. Initiate the Request 
Shipping Charges business process using Siebel CRM, and the application captures estimated 
shipping costs from Oracle GLOG using the GLOG Web service. Source inventory, address, and weight 
(should be greater than zero) is transferred to the Oracle GLOG API to calculate shipping charges, 
and the Oracle GLOG API returns the shipping amount. This data is returned to Siebel CRM so that 
the customer service representative can update the customer. Shipping charges in not applicable for 
complex products.

Actual Freight charge calculations occur only at the time of shipping in Oracle EBS, and these values 
calculated in Oracle EBS are not synchronized back to the Siebel CRM order. For freight calculations 
to occur in Oracle EBS appropriate freight charge modifiers need to be setup. For additional details 
on this setup and usage refer to Oracle Order Management Implementation Guide and Oracle 
Advanced Pricing Implementation Guide.

To request shipping charges

1 Navigate to the Siebel Order window and select All Sales Orders Across Organizations.

2 From the Sales tab, click Query and select a sales order with a status of Pending Order or create 
a new order.

3 Navigate to the Shipping tab, select the account, make sure it has a valid address.

This is the ship to address.

4 Navigate to the Fulfillments sub tab and select the Source at Header level or at Line level for all 
the Line items.

The first preference is to use the Source at the line level, but if that is missing then use the 
Source at Header level. Make sure that the Inventory (Source) has a valid address, which is the 
ship from address.

5 Navigate to the Summary tab and enter the weight of the product, for all the simple products.

6 Click Shipping Charges in the lower applet.

Shipping Charges are returned to Siebel CRM from GLOG.

Pricing, Tax, and Invoicing
Note the following information on pricing, tax, and invoices:

■ Pricing. No price calculation occurs within Oracle EBS Order Management. Therefore do not set 
up or use any discount or surcharge modifiers in Oracle EBS Advanced Pricing.

■ Tax. Tax calculated in Siebel CRM is an estimated value and not synchronized with the order in 
Oracle EBS Order Management. The difference in estimated Tax amount if any, between the two 
applications is not synchronized back to the Siebel order. The actual tax if different from the 
estimated value, is computed during invoicing in Oracle EBS and can be viewed using Oracle EBS 
Accounts Receivable. For the Siebel CRM > Oracle EBS Order Management integrated flow you 
should set Tax Event in the Order Type setup to Invoicing, for the appropriate order type.
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■ Invoicing. Set the profile option OM: Show discount details on invoice to No. Your invoice in this 
case shows the unit selling price multiplied by the quantity.
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6 Troubleshooting
Table 5 is the list of error messages that appear in Siebel CRM. All error messages for Siebel CRM 
Integration Pack for Oracle Order Management have the following error code: SBL-EXL-00151

Table 5. Error Message in Siebel CRM

Error Text Item Notes

A fault has occured in webservice 
following are the details: <list>
Line items for Configurable Product 
are not supported.

ATP Check Error when a single Configurable Product 
is sent to ATP BPEL process (without any 
simple product). This message is formed 
in the BPEL process.

Cannot Sync Quote. Create Quote Error while submitting already created 
Quote.

Credit Card details are incomplete: 
Either of 'Credit Card #' OR 
'Expiration Month' OR 'Expiration Year' 
is missing.

Payment 
Authorization

Error while submitting a Payment 
without Credit Card # OR Expiration 
Month OR Expiration Year.

Credit Check Failed. Please contact 
your system Administrator.

Credit Check Message when Credit Check is failed 
because of the data provided to API.

Credit Check Order limit exceeded. Credit Check Message when Credit Check failed 
because insufficient credit limit.

Credit Check Succeeded. Credit Check Message when Credit Check is 
Successful.

ERROR PROCESSING RATE INQUIRY: 
Please contact Administrator.

Shipping 
Charges

Error when GLOG web service failed due 
to request data (with address not 
configured). This message is formed in 
the BPEL process (concatenating the 
error response from GLOG web service).

getCommonID ORGANIZATION for 
<ID> returns null

Credit Check Error when submitted Credit Check with 
our seeded data. This message is formed 
using the error codes and content sent 
from the BPEL process.

Invalid Order Status. Order Status has 
to be Booked and cannot be NULL.

Create Order Error when submitting an order with a 
status other than Booked.

Inventory Address details is 
incomplete: Either of ‘City’ OR ‘State’ 
OR ‘Country’ OR ‘Zip’ is missing.

Shipping 
Charges

Error when Inventory address is missing 
for the inventory selected at header OR 
at line level.
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Order is incomplete : Bill To Account 
Id or Ship To Account Id or their 
corresponding Address Id's are not 
there.

Create Order Error while submitting an order without 
Account / Bill To Account / Ship To 
Account or their relevant addresses.

Payment Authorization Failed. Please 
contact your system Administrator. 

Payment 
Authorization

Message when Payment Authorization is 
failed because of the data provided to 
iPayment API.

Payment Authorized. Payment 
Authorization

Message when Payment Authorization is 
Successful.

Payment status is either not 
'Approved' or the value is Null!

Create Order Error while submitting an Order with a 
Payment line item and Payment status is 
null or Payment status is not approved.

Quote is incomplete : Bill To Account 
Id or Ship To Account Id or their 
corresponding Address Id's are not 
there.

Create Quote Error while submitting a Quote, without 
an Account / Bill to Account / Ship to 
Account / or their relevant addresses.

Sales Order cannot be submitted as 
its already created.

Create Order Error while submitting already 
processed Order.

Ship to Address details is incomplete: 
Either of ‘City’ OR ‘State’ OR ‘Country’ 
OR ‘Zip’ is missing.

Shipping 
Charges

Error when Ship to address header and 
line level is not provided.

The Order is on Hold. Please Release 
the Hold and Submit the Order.

Create Order Error while submitting an Order with 
Hold flag selected.

The Order selected has more than one 
Payment.

Credit Check Error while submitting Credit Check with 
more than one payment line.

The Order selected has more than one 
Payment.

Payment 
Authorization

Error while submitting Payment 
Authorization with more than one 
payment line.

The value in required field 
<field_name> is null.

Credit Check Error when submitted Credit Check 
without required data. This message is 
formed using the error codes and 
content sent from the BPEL process.

Weight of simple product should be 
greater than '0' (zero).

Shipping 
Charges

Error when product weight is not 
provided.

Table 5. Error Message in Siebel CRM

Error Text Item Notes
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